# Table of contents

1 Product introduction .................................................................................................................................................................................. 1
   Product comparison .................................................................................................................................................................................. 2
   Product views ..................................................................................................................................................................................... 4
      Product front-right view ................................................................................................................................................................. 4
      Product front-left view ................................................................................................................................................................. 5
   Interface ports .................................................................................................................................................................................. 6
      Serial number and model number location ................................................................................................................................. 7
   Control panel .................................................................................................................................................................................... 8
      Control-panel layout ....................................................................................................................................................................... 8
      Control-panel help ......................................................................................................................................................................... 9
   Product reports ............................................................................................................................................................................... 10

2 Connect the product and install software .......................................................................................................................................................... 11
   Connect the product to a computer by using a USB cable and install the software (Windows) ................................................................. 12
   Connect the product to a network by using a network cable and install the software (Windows) ................................................................. 14
      Configure the IP address ................................................................................................................................................................. 14
      Install the software ......................................................................................................................................................................... 15
   Connect the product to a computer by using a USB cable and install the software (Mac OS X) ................................................................. 16
   Connect the product to a network by using a network cable and install the software (Mac OS X) ................................................................. 17
      Configure the IP address ................................................................................................................................................................. 17
      Install the software ......................................................................................................................................................................... 18

3 Input trays and output bins ........................................................................................................................................................................ 21
   Supported paper sizes ......................................................................................................................................................................... 22
   Supported paper types ......................................................................................................................................................................... 25
   Configure trays .................................................................................................................................................................................. 26
      Configure a tray when loading paper .................................................................................................................................................. 26
      Configure a tray to match print job settings ...................................................................................................................................... 26
      Configure a tray by using the control panel ...................................................................................................................................... 26
   Alternative letterhead mode ................................................................................................................................................................. 28
   Tray 1 .............................................................................................................................................................................................................. 29
Change print-job settings (Mac OS X) ................................................................. 63
  Change the settings for all print jobs until the software program is closed .......... 63
  Change the default settings for all print jobs ..................................................... 63
  Change the product configuration settings ......................................................... 63

Print tasks (Windows) .......................................................................................... 64
  Use a printing shortcut (Windows) ..................................................................... 64
  Create printing shortcuts (Windows) ................................................................. 66
  Automatically print on both sides (Windows) ...................................................... 69
  Manually print on both sides (Windows) ............................................................ 71
  Print multiple pages per sheet (Windows) .......................................................... 73
  Select the page orientation (Windows) ............................................................... 75
  Select the paper type (Windows) ...................................................................... 77
  Print the first or last page on different paper (Windows) ................................. 80
  Scale a document to fit page size (Windows) ..................................................... 83
  Create a booklet (Windows) ............................................................................. 85

Print tasks (Mac OS X) .......................................................................................... 87
  Use a printing preset (Mac OS X) ...................................................................... 87
  Create a printing preset (Mac OS X) ............................................................... 87
  Automatically print on both sides (Mac OS X) ............................................... 87
  Manually print on both sides (Mac OS X) ......................................................... 87
  Print multiple pages per sheet (Mac OS X) ..................................................... 88
  Select the page orientation (Mac OS X) .......................................................... 88
  Select the paper type (Mac OS X) ................................................................. 88
  Print a cover page (Mac OS X) ..................................................................... 88
  Scale a document to fit page size (Mac OS X) ................................................. 89
  Create a booklet (Mac OS X) ........................................................................... 89

Additional print tasks (Windows) ......................................................................... 90
  Cancel a print job (Windows) ......................................................................... 90
  Select the paper size (Windows) ................................................................... 90
  Select a custom paper size (Windows) ............................................................ 90
  Print watermarks (Windows) ......................................................................... 91

Additional print tasks (Mac OS X) ..................................................................... 92
  Cancel a print job (Mac OS X) ................................................................. 92
  Select the paper size (Mac OS X) ................................................................. 92
  Select a custom paper size (Mac OS X) ........................................................ 92
  Print watermarks (Mac OS X) ...................................................................... 92

Store print jobs on the product .......................................................................... 94
  Create a stored job (Windows) ..................................................................... 94
  Create a stored job (Mac OS X) ................................................................. 96
  Print a stored job ......................................................................................... 97
  Delete a stored job ....................................................................................... 97
Add a job-separator page (Windows) ................................................................. 98
Use HP ePrint ........................................................................................................ 99
Use the HP ePrint Mobile Driver ........................................................................ 100
Use Apple AirPrint ............................................................................................... 101
  Connect the product to AirPrint ................................................................. 101
  Find the product AirPrint name ................................................................. 101
  Print from AirPrint ...................................................................................... 101
  Change the AirPrint product name .......................................................... 102
  Solve AirPrint problems ............................................................................ 102
Use HP Smart Print (Windows) ........................................................................ 103
Use easy-access USB printing ........................................................................... 104
  Print easy-access USB documents .......................................................... 105

6 Manage the product .......................................................................................... 107

Configure IP network settings ........................................................................... 108
  Printer sharing disclaimer ........................................................................ 108
  View or change network settings ............................................................. 108
  Manually configure IPv4 TCP/IP parameters from the control panel ........ 108
  Manually configure IPv6 TCP/IP parameters from the control panel ........ 109
HP Embedded Web Server ................................................................................. 110
  Open the HP Embedded Web Server ....................................................... 110
  HP Embedded Web Server features ......................................................... 111
    Information tab ...................................................................................... 111
    General tab ......................................................................................... 111
    Print tab ............................................................................................ 112
    Troubleshooting tab ........................................................................... 112
    Security tab ...................................................................................... 113
    HP Web Services tab ....................................................................... 113
    Networking tab ............................................................................... 113
    Other Links list ............................................................................... 113
HP Utility (Mac OS X) ...................................................................................... 114
  Open HP Utility ...................................................................................... 114
  HP Utility features ............................................................................... 114
Use HP Web Jetadmin software ....................................................................... 116
Economy settings ............................................................................................. 117
  Print with EconoMode ......................................................................... 117
  Optimize speed or energy use .............................................................. 117
  Set sleep mode .................................................................................... 117
  Set the sleep schedule ....................................................................... 118
Product security features .................................................................................. 120
  Security statements ............................................................................ 120
7 Solve problems ................................................................................................................................................... 123

Solve problems checklist ...................................................................................................................................... 124
Factors that affect product performance .............................................................................................................. 126
Restore factory-set defaults .................................................................................................................................. 127
Control-panel help ................................................................................................................................................ 128
Paper feeds incorrectly or becomes jammed ......................................................................................................... 129
  The product does not pick up paper .................................................................................................................... 129
  The product picks up multiple sheets of paper ................................................................................................... 129
  Prevent paper jams .............................................................................................................................................. 129
Clear jams ............................................................................................................................................................... 131
  Jam locations .................................................................................................................................................... 131
  Auto-navigation for clearing jams ..................................................................................................................... 131
  Clear jams in the output-bin area ....................................................................................................................... 131
  Clear jams in Tray 1 ......................................................................................................................................... 132
  Clear jams in Tray 2 or Tray 3 .......................................................................................................................... 132
  Clear jams in the 500-sheet trays ....................................................................................................................... 134
  Clear jams in the 3,500-sheet high-capacity tray ............................................................................................ 136
  Clear jams from the toner-cartridge area ........................................................................................................... 139
  Clear jams in the fuser ....................................................................................................................................... 142
  Clear jams from the duplexer ............................................................................................................................ 144
Change jam recovery .............................................................................................................................................. 146
Improve print quality ............................................................................................................................................. 147
  Print from a different software program ........................................................................................................... 147
  Set the paper-type setting for the print job ......................................................................................................... 147
    Check the paper type setting (Windows) ......................................................................................................... 147
    Check the paper type setting (Mac OS X) ....................................................................................................... 147
  Check the toner-cartridge status ....................................................................................................................... 148
  Print a cleaning page ....................................................................................................................................... 148
  Visually inspect the toner cartridge ................................................................................................................... 149
  Check paper and the printing environment ....................................................................................................... 149
    Use paper that meets HP specifications ........................................................................................................ 149
    Check the environment .................................................................................................................................. 150
  Check the EconoMode settings ........................................................................................................................... 150
  Try a different print driver ................................................................................................................................. 151
Set the individual tray alignment ........................................................................................................ 151
The product does not print or it prints slowly .................................................................................... 153
The product does not print ................................................................................................................. 153
The product prints slowly .................................................................................................................... 153
Solve easy-access USB printing problems .......................................................................................... 154
The Retrieve From USB menu does not open when you insert the USB flash drive .................... 154
The file does not print from the USB flash drive .............................................................................. 154
The file that you want to print is not listed in the Retrieve from USB menu ................................. 155
Solve USB connection problems ....................................................................................................... 156
Solve wired network problems .......................................................................................................... 157
The product has a poor physical connection ..................................................................................... 157
The computer is using the incorrect IP address for the product ...................................................... 157
The computer is unable to communicate with the product ................................................................. 157
The product is using incorrect link and duplex settings for the network .......................................... 158
New software programs might be causing compatibility problems ............................................... 158
The computer or workstation might be set up incorrectly ............................................................... 158
The product is disabled, or other network settings are incorrect .................................................... 158
Solve product software problems (Windows) .................................................................................... 159
A print driver for the product is not visible in the Printer folder ...................................................... 159
An error message was displayed during the software installation ................................................ 159
The product is in Ready mode, but nothing prints ........................................................................... 159
Solve product software problems (Mac OS X) .................................................................................. 161
The product name does not appear in the product list in the Print & Fax or the Print & Scan list .... 161
A print job was not sent to the product that you wanted ................................................................. 161
When connected with a USB cable, the product does not appear in the Print & Fax or the Print & Scan list after the driver is selected .............................................................. 161
Remove software (Windows) ........................................................................................................... 162
Remove the print driver (Mac OS X) ................................................................................................ 163
Index ...................................................................................................................................................... 165
1 Product introduction

- Product comparison
- Product views
- Control panel
- Product reports
## Product comparison

<table>
<thead>
<tr>
<th>Feature</th>
<th>M712n CF235A</th>
<th>M712dn CF236A</th>
<th>M712xh CF238A</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Paper handling</strong></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Tray 1 (100-sheet capacity)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Tray 2 (250-sheet capacity)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Tray 3 (250-sheet capacity)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Optional Tray 4 (500-sheet capacity)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Standard output bin (250-sheet capacity)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Automatic duplex printing</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Connectivity</strong></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Hi-Speed USB 2.0</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>10/100/1000 Ethernet LAN connection with IPv4 and IPv6</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Easy-access USB port, for printing without a computer and for upgrading the firmware</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Memory</strong></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>512 MB DIMM</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Storage</strong></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>16 GB Solid-State Memory module</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>320 GB HP High-Performance Secure Hard Disk</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Control-panel display</strong></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>4-line LCD with 10-key numeric keypad</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Print</strong></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Prints 41 pages per minute (ppm) on A4-size paper and 40 ppm on Letter-size paper</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Easy-access USB printing (no computer required)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Supported operating systems</strong></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Windows XP SP2 or later, 32-bit</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>NOTE:</strong> For a current list of supported operating systems, go to <a href="http://www.hp.com/go/lj700M712_software">www.hp.com/go/lj700M712_software</a>.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows XP SP2 or later, 64-bit (print driver only, not supported by the software installer)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>NOTE:</strong> Microsoft retired mainstream support for Windows XP in April 2009. HP will continue to provide best-effort support for the discontinued XP operating system.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows Vista, 32-bit and 64-bit</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>NOTE:</strong> Windows Vista Starter is not supported by the software installer or the print driver.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows 7, 32-bit and 64-bit</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Windows 8, 32-bit and 64-bit</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>NOTE:</strong> The software installer does not support the 64-bit version, but the print driver supports it.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

2  Chapter 1  Product introduction  ENWW
<table>
<thead>
<tr>
<th></th>
<th>M712n CF235A</th>
<th>M712dn CF236A</th>
<th>M712xh CF238A</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 2003 Server SP1 or later, 32-bit and 64-bit</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Windows 2008, 32-bit and 64-bit</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Windows 2008 R2, 64-bit</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Mac OS X 10.6, 10.7, and 10.8</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>
# Product views

## Product front-right view

<table>
<thead>
<tr>
<th>Number</th>
<th>Feature</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Output bin</td>
</tr>
<tr>
<td>2</td>
<td>Cartridge-door-release button</td>
</tr>
<tr>
<td>3</td>
<td>Output-bin extension</td>
</tr>
<tr>
<td>4</td>
<td>Tray 1</td>
</tr>
<tr>
<td>5</td>
<td>Formatter (contains the interface ports)</td>
</tr>
<tr>
<td>6</td>
<td>Right-side access door</td>
</tr>
<tr>
<td>7</td>
<td>Handles for lifting the product</td>
</tr>
<tr>
<td>8</td>
<td>500-sheet tray jam-access door</td>
</tr>
<tr>
<td>9</td>
<td>Handles for lifting the product</td>
</tr>
<tr>
<td>10</td>
<td>500-sheet tray (included with the M712xh model)</td>
</tr>
<tr>
<td>11</td>
<td>Tray 3</td>
</tr>
<tr>
<td>12</td>
<td>Tray 2</td>
</tr>
<tr>
<td>13</td>
<td>On/off button</td>
</tr>
</tbody>
</table>
## Product front-left view

<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Hardware integration pocket (for connecting third-party devices)</td>
</tr>
<tr>
<td>2</td>
<td>Control panel</td>
</tr>
<tr>
<td>3</td>
<td>Easy-access USB port (for printing without a computer and for upgrading the firmware)</td>
</tr>
<tr>
<td>4</td>
<td>Handles for lifting the product</td>
</tr>
<tr>
<td>5</td>
<td>Handles for lifting the product</td>
</tr>
<tr>
<td>6</td>
<td>Lever to lock the 500-sheet tray to the product</td>
</tr>
<tr>
<td>7</td>
<td>Power connection</td>
</tr>
<tr>
<td>8</td>
<td>Duplexer (included with the M712dn and M712xh models)</td>
</tr>
<tr>
<td>9</td>
<td>Fuser jam-access cover</td>
</tr>
</tbody>
</table>
Interface ports

1. Local area network (LAN) Ethernet (RJ-45) network port
2. Hi-Speed USB 2.0 printing port
3. USB port for connecting external USB devices
Serial number and model number location

The serial number and model number are listed on an identification label located on the back of the product. The serial number contains information about the country/region of origin, the product version, production code, and the production number of the product.

<table>
<thead>
<tr>
<th>Model name</th>
<th>Model number</th>
</tr>
</thead>
<tbody>
<tr>
<td>M712n</td>
<td>CF235A</td>
</tr>
<tr>
<td>M712dn</td>
<td>CF236A</td>
</tr>
<tr>
<td>M712xh</td>
<td>CF238A</td>
</tr>
</tbody>
</table>
Control panel

Control-panel layout

Use the control panel to obtain product and job status information and to configure the product.

<table>
<thead>
<tr>
<th>Number</th>
<th>Button or light</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Control-panel display</td>
<td>Shows status information, menus, help information, and error messages</td>
</tr>
<tr>
<td>2</td>
<td>🛑 Stop button</td>
<td>Cancels the current print job and clears the pages from the product</td>
</tr>
<tr>
<td>3</td>
<td>⚫ Help button</td>
<td>Provides information about the message on the control-panel display</td>
</tr>
<tr>
<td>4</td>
<td>⬇ Down arrow</td>
<td>Navigates to the next item in the list, or decreases the value of numeric items</td>
</tr>
<tr>
<td>5</td>
<td>⬆ Up arrow</td>
<td>Navigates to the previous item in the list, or increases the value of numeric items</td>
</tr>
</tbody>
</table>
| 6      | OK button | • Saves the selected value for an item.  
• Performs the action that is associated with the item that is highlighted on the control-panel display.  
• Clears an error condition when the condition is clearable. |
| 7      | Numeric keypad | Enter numeric values |
| 8      | Clear button | Returns values to their defaults and closes the help screen |
| 9      | 🗂 Folder button | Provides quick access to the **Retrieve Job** menu |
| 10     | ⚠️ Attention light | • **On**: The product has experienced a problem. See the control-panel display.  
• **Off**: The product is functioning without error.  
• **Blinking**: Action is required. See the control-panel display. |
<table>
<thead>
<tr>
<th>Number</th>
<th>Button or light</th>
<th>Function</th>
</tr>
</thead>
</table>
| 11     | Ready light    | ● On: The product is online and ready to accept data to print.  
        |                 | ● Off: The product cannot accept data because it is offline (paused) or has experienced an error.  
        |                 | ● Blinking: The product is going offline. The product stops processing the current job and expels all of the active pages from the paper path. |
| 12     | Home button    | Opens and closes the menus |
| 13     | Back button    | Backs up one level in the menu tree or backs up one numeric entry |
| 14     | Easy-access USB| For printing without a computer |

**Control-panel help**

The product has a built-in Help system that explains how to use each screen. To open the Help system, press the Help button on the control panel.

For some screens, the Help button opens to a global menu where you can search for specific topics. You can browse through the menu structure by pressing the arrow buttons on the control panel.

For screens that contain settings for individual jobs, the Help button opens to a topic that explains the options for that screen.
Product reports

Product reports provide details about the product and its current configuration. Use the following procedure to print the reports:

1. At the product control panel, press the Home button.

2. Open the following menus:
   - Administration
   - Reports

3. Select the name of the report you want to review, scroll up to the Print option, and then press the OK button to print the report.

Table 1-1 Reports menu

<table>
<thead>
<tr>
<th>First level</th>
<th>Second level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration/Status Pages</td>
<td>Administration Menu Map</td>
<td>Shows the structure of the Administration menu.</td>
</tr>
<tr>
<td>Current Settings Page</td>
<td></td>
<td>Shows the current settings for each option in the Administration menu.</td>
</tr>
<tr>
<td>Configuration Page</td>
<td></td>
<td>Shows the product settings and installed accessories.</td>
</tr>
<tr>
<td>Supplies Status Page</td>
<td></td>
<td>Shows the approximate remaining life for the supplies; reports statistics on total number of pages and jobs processed, serial number, page counts, and maintenance information.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>HP provides approximations of the remaining life for the supplies as a customer convenience. The actual remaining supply levels might be different than the approximations provided.</td>
</tr>
<tr>
<td>Usage Page</td>
<td></td>
<td>Shows a count of all paper sizes that have passed through the product; lists whether they were simplex or duplex, and reports the page count.</td>
</tr>
<tr>
<td>File Directory Page</td>
<td></td>
<td>Shows the file name and folder name for files that are stored in the product memory.</td>
</tr>
<tr>
<td>Web Services Status Page</td>
<td></td>
<td>Shows the detected Web Services for the product.</td>
</tr>
<tr>
<td>Other Pages</td>
<td>PCL Font List</td>
<td>Prints the available PCL fonts.</td>
</tr>
<tr>
<td></td>
<td>PS Font List</td>
<td>Prints the available HP postscript level 3 emulation fonts.</td>
</tr>
</tbody>
</table>
2 Connect the product and install software

- Connect the product to a computer by using a USB cable and install the software (Windows)
- Connect the product to a network by using a network cable and install the software (Windows)
- Connect the product to a computer by using a USB cable and install the software (Mac OS X)
- Connect the product to a network by using a network cable and install the software (Mac OS X)
Connect the product to a computer by using a USB cable and install the software (Windows)

This product supports a USB 2.0 connection. Use an A-to-B type USB cable. HP recommends using a cable that is no longer than 2 m (6.5 ft).

⚠️ CAUTION: Do not connect the USB cable until the installation software prompts you to connect it.

1. Close all open programs on the computer.
2. Verify the product is in the Ready state.

💡 NOTE: When the product is connected with a USB cable, the software installation process requires that the product is turned on and in the Ready state. Configure the following setting so the product wakes from Sleep mode during the software installation process and whenever it receives a print job:

   a. On the product control panel, press the Home button.
   b. Open the following menus:
      - Administration
      - General Settings
      - Energy Settings
      - Sleep Timer Settings
      - Wake/Auto On Events
   c. Highlight the All events option and press the OK button.

3. Install the software from the CD, and follow the on-screen instructions.
4. When prompted, select the Directly connect to this computer using USB cable option, and then click the Next button.
5. When the software prompts you, connect the USB cable to the product and the computer.

6. At the end of the installation, click the **Finish** button, or click the **More Options** button to install more software or configure basic digital sending features for the product.

7. Print a page from any program to make sure that the software is correctly installed.
Connect the product to a network by using a network cable and install the software (Windows)

Configure the IP address

1. Make sure the product is turned on and that the Ready message displays on the product control-panel display.

2. Connect the network cable to the product and to the network.

3. Wait for 60 seconds before continuing. During this time, the network recognizes the product and assigns an IP address or host name for the product.

4. To identify the product IP address or host name, on the product control panel press the Home button, open the How to Connect menu, and select the Network Address option.

You can also find the IP address or host name by printing a configuration page.

a. On the product control panel, press the Home button.

b. Open the following menus:
   - Administration
   - Reports
   - Configuration/Status Pages

c. Select the Configuration Page option.

d. Scroll up to the Print option, and then press the OK button.
e. Find the IP address on the Jetdirect page.

IPv4: If the IP address is 0.0.0.0, or 192.0.0.192, or 169.254.x.x, you must manually configure the IP address. Otherwise, the network configuration was successful.

IPv6: If the IP address begins with "fe80:", the product should be able to print. If not, you must manually configure the IP address.

Install the software

1. Close all programs on the computer.
2. Install the software from the CD.
3. Follow the on-screen instructions.
4. When prompted, select the Connect through a wired network option.
5. From the list of available products, select the one that has the correct IP address. If the product is not listed, manually enter the product's IP Address, Host Name, or Hardware Address.
6. At the end of the installation, click the Finish button, or click the More Options button to install more software or configure basic digital sending features for the product.
7. Print a page from any program to make sure that the software is correctly installed.
Connect the product to a computer by using a USB cable and install the software (Mac OS X)

This product supports a USB 2.0 connection. Use an A-to-B type USB cable. HP recommends using a cable that is no longer than 2 m (6.5 ft).

1. Connect the USB cable to the product and the computer.

2. Verify the product is in the Ready state.

   **NOTE:** When the product is connected with a USB cable, the software installation process requires that the product is turned on and in the Ready state. Configure the following setting so the product wakes from Sleep mode during the software installation process and whenever it receives a print job:

   a. On the product control panel, press the Home button.
   b. Open the following menus:
      - Administration
      - General Settings
      - Energy Settings
      - Sleep Timer Settings
      - Wake/Auto On Events
   c. Highlight the All events option and press the OK button.

3. Install the software from the CD.
4. Click the product icon, and follow the on-screen instructions.
5. Click the Close button.
6. Print a page from any program to make sure that the software is correctly installed.
Connect the product to a network by using a network cable and install the software (Mac OS X)

Configure the IP address

1. Make sure the product is turned on and that the Ready message displays on the product control-panel display.

2. Connect the network cable to the product and to the network.

3. Wait for 60 seconds before continuing. During this time, the network recognizes the product and assigns an IP address or host name for the product.

4. To identify the product IP address or host name, on the product control panel press the Home button, open the How to Connect menu, and select the Network Address option.

You can also find the IP address or host name by printing a configuration page.

   a. On the product control panel, press the Home button.

   b. Open the following menus:

      - Administration
      - Reports
      - Configuration/Status Pages

   c. Select the Configuration Page option.

   d. Scroll up to the Print option, and then press the OK button.
e. Find the IP address on the Jetdirect page.

5. IPv4: If the IP address is 0.0.0.0, or 192.0.0.192, or 169.254.x.x, you must manually configure the IP address. Otherwise, the network configuration was successful.

IPv6: If the IP address begins with "fe80:", the product should be able to print. If not, you must manually configure the IP address.

Install the software

1. Close all programs on the computer.
2. Install the software from the CD.
3. Click the product icon, and follow the on-screen instructions.
4. Click the Close button when the installation is complete.

**NOTE:** Complete the following steps after completing the printing-system software installation only if you did not add a printer when running the installer.

5. At the computer, open the Apple menu, click the System Preferences menu, and then click the Print & Fax icon (OS X v10.5 and 10.6) or the Print & Scan icon (OS X v10.7).
6. Click the plus symbol (+).
7. Use either Bonjour (default browser) or IP Printing for the network connection.

**NOTE:** Bonjour is the easiest and best method to use if the product is installed on your local network.

IP Printing must be used to install the product on a different network.

If you are using Bonjour, complete the following steps:
a. Click the **Default Browser** tab.

b. Select the product from the list. The software verifies that the product is connected to the network. The **Print Using** field is automatically populated with the correct PPD for the product.

**NOTE:** If you are on a network that has more than one product, print a configuration page and match the Bonjour Printer Name to the name on the list to identify the product that you are installing.

**NOTE:** If the product does not appear in the list, verify that the product is on and connected to the network, then try turning the product off and then on again. If the product PPD is not in the **Print Using** drop-down list, turn the computer off and then on again, and then restart the setup process.

c. Click the Add button to complete the setup process.

If you are using the IP Printing method, complete the following steps:

a. Click the **IP Printer** tab.

b. Choose **HP Jet Direct – Socket** from the **Protocol** drop-down menu. This is the recommended setting for HP products.

c. Type the IP address into the **Address** field on the add printer screen.

d. The **Name**, **Location**, and **Print Using** information are automatically filled in. If the product PPD is not in the **Print Using** field, turn the computer off and then on again, and then restart the setup process.
3 Input trays and output bins

- Supported paper sizes
- Supported paper types
- Configure trays
- Alternative letterhead mode
- Tray 1
- Tray 2 and Tray 3
- 500-sheet trays
- 3,500-sheet high-capacity tray
- Load and print labels
- Use paper output options
## Supported paper sizes

**NOTE:** To obtain the best results, select the correct paper size and type in the print driver before printing.

### Table 3-1 Supported paper sizes

<table>
<thead>
<tr>
<th>Size and dimensions</th>
<th>Tray 1</th>
<th>Tray 2</th>
<th>Tray 3</th>
<th>Optional 500-sheet trays</th>
<th>3,500-sheet high-capacity tray</th>
<th>Automatic duplex printing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Letter</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>279 x 216 mm (11 x 8.5 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Letter Rotated</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>216 x 279 mm (8.5 x 11 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Legal</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>216 x 356 mm (8.5 x 14 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Executive</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>267 x 184 mm (10.5 x 7.3 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Statement</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>216 x 140 mm (8.5 x 5.5 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Oficio 8.5 x 13</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>216 x 330 mm (8.5 x 13 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11 x 17</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>279 x 432 mm (11 x 17 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12 x 18</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>305 x 457 mm (12 x 18 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 x 5</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>76 x 127 mm (3 x 5 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4 x 6</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>102 x 152 mm (4 x 6 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5 x 7</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>127 x 178 mm (5 x 7 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5 x 8</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>127 x 203 mm (5 x 8 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A3</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>297 x 420 mm (11.7 x 16.5 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A4</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>297 x 210 mm (11.7 x 8.3 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Size and dimensions</td>
<td>Tray 1</td>
<td>Tray 2</td>
<td>Tray 3</td>
<td>Optional 500-sheet trays</td>
<td>3,500-sheet high-capacity tray</td>
<td>Automatic duplex printing</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------</td>
<td>--------</td>
<td>--------</td>
<td>--------------------------</td>
<td>-------------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>A4 Rotated</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>210 x 297 mm (8.3 x 11.7 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A5</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>210 x 148 mm (8.3 x 5.8 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A6</td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>105 x 148 mm (4.1 x 5.8 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RA3</td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>305 x 430 mm (12 x 17 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RA4</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>215 x 305 mm (8.5 x 12.0 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SRA4</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>225 x 320 mm (8.9 x 12 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B4 (JIS)</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>257 x 364 mm (10.1 x 14.3 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B5 (JIS)</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>257 x 182 mm (10.1 x 7.2 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B6 (JIS)</td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>128 x 182 mm (5.0 x 7.2 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10 x 15 cm</td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>102 x 152 mm (4 x 6 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>216 x 343 mm (8.5 x 14 in)</td>
<td></td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Oficio 216 x 347</td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>216 x 347 mm (8.5 x 13.7 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8K 270 x 390 mm</td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>270 x 390 mm (10.6 x 15.4 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16K 195 x 270 mm</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>270 x 195 mm (10.6 x 7.7 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8K 260 x 368 mm</td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>260 x 368 mm (10.2 x 14.5 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16K 184 x 260 mm</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>260 x 184 mm (10.2 x 7.2 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Size and dimensions</td>
<td>Tray 1</td>
<td>Tray 2</td>
<td>Tray 3</td>
<td>Optional 500-sheet trays</td>
<td>3,500-sheet high-capacity tray</td>
<td>Automatic duplex printing</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------</td>
<td>--------</td>
<td>--------</td>
<td>--------------------------</td>
<td>-------------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>8K 273 x 394 mm</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>273 x 394 mm (10.8 x 16 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16K 197 x 273 mm</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>273 x 197 mm (10.8 x 7.8 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Postcard (JIS)</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>100 x 148 mm (3.9 x 5.8 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D Postcard (JIS)</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>148 x 200 mm (5.8 x 7.9 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Envelope #9</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>98 x 225 mm (3.9 x 8.9 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Envelope #10</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>105 x 241 mm (4.1 x 9.5 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Envelope Monarch</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>98 x 191 mm (3.9 x 7.5 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Envelope B5</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>176 x 250 mm (6.9 x 9.8 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Envelope C5</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>162 x 229 mm (6.4 x 9.0 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Envelope C6</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>114 x 162 mm (4.5 x 6.4 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Envelope DL</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>110 x 220 mm (4.3 x 8.7 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>76 x 127 mm to 312 x 470 mm (3.0 x 5.0 in) to (12.3 x 18.5 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Banner printing from Tray 1: Length from 470 mm to 508 mm (18.5 in to 20 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>148 x 210 mm to 364 x 297 mm (5.8 x 8.3 in) to (14.3 x 11.7 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>148 x 210 mm to 432 x 297 mm (5.8 x 8.3 in) to (17 x 12.7 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Supported paper types

For a complete list of specific HP-brand paper that this product supports, go to [www.hp.com/support/lj700M712](http://www.hp.com/support/lj700M712).

**NOTE:** To obtain the best results, select the correct paper size and type in the print driver before printing.

Table 3-2  Supported paper types

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Tray 1</th>
<th>Tray 2 and Tray 3</th>
<th>Optional 500-sheet trays</th>
<th>3,500-sheet high-capacity tray</th>
<th>Automatic duplex printing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>HP EcoSMART Lite</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Light 60–74 g</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Intermediate 85–95 g</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Bond</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Recycled</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Mid-Weight 96–110 g</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Heavy 111–130 g</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Extra Heavy 131–175 g</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cardstock 176–220 g</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transparency</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Labels</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Letterhead</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Envelope</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Heavy Envelope</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Preprinted</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Prepunched</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Colored</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Rough</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Heavy Rough</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Configure trays

The product automatically prompts you to configure a tray for type and size in the following situations:

- When you load paper into the tray
- When you specify a particular tray or paper type for a print job through the print driver or a software program and the tray is not configured to match the print-job's settings

**NOTE:** The prompt does not display if you are printing from Tray 1, and Tray 1 is configured for the *Any Size* paper size and the *Any Type* paper type settings. In this situation, if the print job does not specify a tray, the product prints from Tray 1, even if the paper size and type settings in the print job do not match the paper loaded in Tray 1.

Configure a tray when loading paper

1. Load paper in the tray. If you are using Tray 2 or Tray 3, close the tray.
2. The tray configuration message displays on the product control panel.
3. Do one of the following:
   - Press the **OK** button to accept the detected size and type.
   - To modify the paper size or type for the tray, select the **Modify** option, and then press the **OK** button.
     a. Highlight the correct size, and then press the **OK** button.
     b. Highlight the correct type, and then press the **OK** button.

Configure a tray to match print job settings

1. In the software program, specify the source tray, the paper size, and the paper type.
2. Send the job to the product.
   If the tray needs to be configured, a tray configuration message displays on the product control panel.
3. Load the tray with the specified type and size of paper, and then close the tray.
4. Do one of the following:
   - Press the **OK** button to accept the detected size and type.
   - To modify the paper size or type for the tray, select the **Modify** option, and then press the **OK** button.
     a. Highlight the correct size, and then press the **OK** button.
     b. Highlight the correct type, and then press the **OK** button.

Configure a tray by using the control panel

You can also configure the trays for type and size without a prompt from the product.
1. On the product control panel, press the Home button.

2. Open the **Trays** menu.

3. Highlight the paper size or type setting for the tray that you want to configure, and then press the **OK** button.

4. Highlight the paper size or paper type from the list of options, and then press the **OK** button.
Alternative letterhead mode

Use the Alternative Letterhead Mode feature so that you can load letterhead or preprinted paper into the tray the same way for all print or copy jobs, whether you are printing or copying to one side of the sheet of paper or to both sides. When using this mode, load paper the same way you would for automatic duplex printing.

To use the feature, enable it by using the product control-panel menus. To use the feature with Windows, you also need to enable the feature in the print driver and configure the paper type in the print driver.

Enable Alternative Letterhead Mode by using the product control-panel menus

1. On the product control panel, press the Home button.
2. Open the following menus:
   - Administration
   - Manage Trays
   - Alternative Letterhead Mode
3. Select the Enable option, and press the OK button.

To print with Alternative Letterhead Mode for Windows, perform the following procedure for each print job.

Print with Alternative Letterhead Mode (Windows)

1. From the software program, select the Print option.
2. Select the product, and then click the Properties or Preferences button.
3. Click the Advanced tab.
4. Expand the Printer Features list.
5. Open the Alternative Letterhead Mode drop-down list, and click the On option.
6. Click the Apply button.
7. Click the Paper/Quality tab.
8. From the Paper type drop-down list, click the More... option.
9. Expand the list of Type is: options.
10. Expand the list of Other options, and then click the Letterhead option. Click the OK button.
11. Click the OK button to close the Document Properties dialog box. In the Print dialog box, click the OK button to print the job.
Tray 1

Tray capacity and paper orientation

To prevent jams, do not overfill trays. Be sure the top of the stack is below the tray-full indicator. For short/narrow and heavy/glossy paper, load paper to less than half of the tray-full indicators.

Table 3-3  Tray 1 capacity

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Specifications</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper</td>
<td>Range: 60 g/m² (16 lb) to 199 g/m² (53 lb)</td>
<td>Maximum stack height: 13 mm (0.5 in)</td>
</tr>
<tr>
<td></td>
<td>Up to 100 sheets of 60 to 120 g/m² (16 to 32 lb)</td>
<td>Fewer than 100 sheets of (120 to 199 g/m²) (32 to 53 lb) paper</td>
</tr>
<tr>
<td>Envelopes</td>
<td>75 g/m² (20 lb) to 90 g/m² (24 lb)</td>
<td>Up to 10 envelopes</td>
</tr>
<tr>
<td>Labels</td>
<td>up to 0.23 mm (9 mils) thick</td>
<td>Maximum stack height: 13 mm (0.5 in)</td>
</tr>
<tr>
<td>Transparencies</td>
<td>0.10 to 0.13 mm (4 to 5 mils) thick</td>
<td>Maximum stack height: 13 mm (0.5 in)</td>
</tr>
</tbody>
</table>

Table 3-4  Tray 1 paper orientation

<table>
<thead>
<tr>
<th>Single-sided printing</th>
<th>Manual duplex printing and Alternative Letterhead Mode</th>
<th>Envelopes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Face-up</td>
<td>Face-down</td>
<td>Face-up</td>
</tr>
<tr>
<td>Top edge leading into the product</td>
<td>Long edge leading into the product, top edge at the front of the product</td>
<td>Short, postage end leading into the product</td>
</tr>
</tbody>
</table>
Load Tray 1

1. Open Tray 1.

2. Pull out the paper support.

3. For paper larger than Letter or A4 size, fold out the extension.
4. Slide the paper-width guides wider than the paper.

5. Load the paper into the tray. Make sure that the paper fits under the tabs and below the maximum-height indicators.

6. Adjust the paper-width guides so that they lightly touch the paper stack but do not bend the paper.
Tray 2 and Tray 3

Tray capacity and paper orientation

To prevent jams, do not overfill trays. Be sure the top of the stack is below the tray-full indicator. For short/narrow and heavy/glossy paper, load paper to less than half of the tray-full indicators.

Table 3-5  Tray 2 and Tray 3 capacity

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Specifications</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper</td>
<td>Range: 60 g/m² (16 lb) to 130 g/m² (35 lb)</td>
<td>Equivalent to 250 sheets of 75 g/m² (20 lb)</td>
</tr>
</tbody>
</table>

Table 3-6  Tray 2 and Tray 3 paper orientation

<table>
<thead>
<tr>
<th>Single-sided printing</th>
<th>Automatic duplex printing and Alternative Letterhead Mode</th>
<th>Envelopes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Face-down Top edge at the front of the tray</td>
<td>Face-up Bottom edge at the front of the tray</td>
<td>Print envelopes only from Tray 1.</td>
</tr>
</tbody>
</table>
Load Tray 2 and Tray 3

1. Open the tray.

2. Adjust the paper-guides to the correct paper size.
3. Load the paper into the tray. Make sure that the stack is flat at all four corners and that the top of the stack is below the maximum-height indicators.

4. Close the tray.
500-sheet trays

500-sheet tray capacity and paper orientation

To prevent jams, do not overfill trays. Be sure the top of the stack is below the tray-full indicator. For short/narrow and heavy/glossy paper, load paper to less than half of the tray-full indicators.

Table 3-7 500-sheet tray capacity

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Specifications</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper</td>
<td>Range: 60 g/m² (16 lb) to 130 g/m² (35 lb)</td>
<td>Equivalent to 500 sheets of 75 g/m² (20 lb)</td>
</tr>
</tbody>
</table>

Table 3-8 500-sheet tray paper orientation

<table>
<thead>
<tr>
<th>Single-sided printing</th>
<th>Automatic duplex printing and Alternative Letterhead Mode</th>
<th>Envelopes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Face-down</td>
<td>Face-up</td>
<td>Print envelopes only from Tray 1.</td>
</tr>
<tr>
<td>Top edge at the front of the tray</td>
<td>Bottom edge at the front of the tray</td>
<td></td>
</tr>
</tbody>
</table>
Load the 500-sheet trays

1. Open the tray.

2. Adjust the paper-size guides to the correct paper size.
3. Load the paper into the tray. Make sure that the stack is flat at all four corners and that the top of the stack is below the maximum-height indicators.

4. Close the tray.
3,500-sheet high-capacity tray

3,500-sheet high-capacity input capacity and paper orientation

To prevent jams, do not overfill trays. Be sure the top of the stack is below the tray-full indicator. For short/narrow and heavy/glossy paper, load paper to less than half of the tray-full indicators.

**Table 3-9 3,500-sheet high-capacity input tray capacity**

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Specifications</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper</td>
<td>Range: 60 g/m² (16 lb) to 130 g/m² (35 lb)</td>
<td>Equivalent to 3,500 sheets of 75 g/m² (20 lb)</td>
</tr>
</tbody>
</table>

**Table 3-10 3,500-sheet high-capacity input tray paper orientation**

<table>
<thead>
<tr>
<th>Single-sided printing</th>
<th>Automatic duplex printing and Alternative Letterhead Mode</th>
<th>Envelopes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Face-up</td>
<td>Face-down</td>
<td>Print envelopes only from Tray 1.</td>
</tr>
<tr>
<td>Top edge at the back of the tray</td>
<td>Top edge at the back of the tray</td>
<td></td>
</tr>
</tbody>
</table>

Load the 3,500-sheet high-capacity tray

The 3,500-sheet high-capacity tray supports only A4 and Letter-size paper.

1. Open the right and left sides of the tray.
2. On each side, adjust the paper-size lever to the correct position for the paper you are using.

3. Load full reams of paper into each side of the tray. The right side holds 1,500 sheets of paper. The left side holds 2,000 sheets of paper.
   
   **NOTE:** For best results, load full reams of paper. Avoid dividing reams into smaller sections.

4. Close the right and left sides of the tray.
Load and print labels

Introduction

To print on sheets of labels, use Tray 2 or one of the optional 550-sheet trays. Tray 1 does not support labels.

To print labels using the manual feed option, follow these steps to select the correct settings in the print driver, and then load the labels into the tray after sending the print job to the printer. When using manual feed, the printer waits to print the job until it detects the tray has been opened and closed.

Manually feed labels

1. From the software program, select the Print option.
2. Select the printer from the list of printers, and then click or tap the Properties or Preferences button to open the print driver.

   **NOTE:** The name of the button varies for different software programs.

   **NOTE:** To access these features from a Windows 8 or 8.1 Start screen, select Devices, select Print, and then select the printer.

3. Click or tap the Paper/Quality tab.
4. In the Paper size drop-down list, select the correct size for the sheets of labels.
5. In the Paper type drop-down list, select Labels.

   **NOTE:** When using manual feed, the printer prints from the lowest-numbered tray that is configured for the correct size of paper, so it is not necessary to specify a particular tray. For example, if Tray 2 is configured for labels, the printer will print from Tray 2. If Tray 3 is installed and configured for labels, but Tray 2 is not configured for labels, the printer will print from Tray 3.

7. Click the OK button to close the Document Properties dialog box.
8. In the Print dialog box, click the OK button to print the job.
9. Load sheets of labels face-up with the top of the sheet toward the right side of the printer.
Use paper output options

Output bin

The standard output bin collects paper face-down, in the correct order.

The standard output bin holds up to 250 sheets of 75 g/m² (20 lb) paper.
4 Parts, supplies, and accessories

- Order parts, accessories, and supplies
- HP policy on non-HP supplies
- HP anticyounterfeit Web site
- Print when a toner cartridge is at estimated end of life
- Enable or disable the Very Low Settings options from the control panel
- Customer self-repair parts
- Accessories
- Toner cartridge
## Order parts, accessories, and supplies

<table>
<thead>
<tr>
<th>Order supplies and paper</th>
<th><a href="http://www.hp.com/go/suresupply">www.hp.com/go/suresupply</a></th>
</tr>
</thead>
<tbody>
<tr>
<td>Order genuine HP parts or accessories</td>
<td><a href="http://www.hp.com/buy/parts">www.hp.com/buy/parts</a></td>
</tr>
<tr>
<td>Order through service or support providers</td>
<td>Contact an HP-authorized service or support provider.</td>
</tr>
<tr>
<td>Order using HP software</td>
<td>The HP Embedded Web Server contains a link to the HP SureSupply Web site, which provides options for purchasing Original HP supplies.</td>
</tr>
</tbody>
</table>
HP policy on non-HP supplies

HP Company cannot recommend the use of non-HP toner cartridges, either new or remanufactured.

**NOTE:** For HP printer products, the use of a non-HP toner cartridge or a refilled toner cartridge does not affect either the warranty to the customer or any HP support contract with the customer. However, if product failure or damage is attributable to the use of a non-HP toner cartridge or refilled toner cartridge, HP will charge its standard time and materials charges to service the product for the particular failure or damage.
HP anticounterfeit Web site

Go to www.hp.com/go/anticounterfeit when you install an HP toner cartridge and the control-panel message says the cartridge is non-HP. HP will help determine if the cartridge is genuine and take steps to resolve the problem.

Your toner cartridge might not be a genuine HP toner cartridge if you notice the following:

- The supplies status page indicates that a non-HP supply is installed.
- You are experiencing a high number of problems with the cartridge.
- The cartridge does not look like it usually does (for example, the packaging differs from HP packaging).
**Print when a toner cartridge is at estimated end of life**

<table>
<thead>
<tr>
<th>Supply Level</th>
<th>Message Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Supply&gt; Low</td>
<td>This message displays when a supply is nearing the estimated end of its useful life.</td>
</tr>
<tr>
<td>&lt;Supply&gt; Very Low</td>
<td>This message displays when a supply is at its estimated end of useful life. Print-quality problems can occur when using a supply that is at its estimated end of life.</td>
</tr>
</tbody>
</table>

Continue printing with the current cartridge until redistributing the toner no longer yields acceptable print quality. To redistribute the toner, remove the toner cartridge from the printer and gently rock the cartridge back and forth about its horizontal axis. For graphical representation, see cartridge replacement instructions. Reinsert the toner cartridge into the printer and close the cover.
Enable or disable the Very Low Settings options from the control panel

You can enable or disable the default settings at any time, and you do not have to re-enable them when you install a new cartridge.

1. From the product control panel, press the Home button.

2. Open the following menus:
   - Administration
   - Manage Supplies
   - Supply Settings

3. Open one of the following options:
   - Black Cartridge
   - Maintenance Kit

4. Select the Very Low Settings option.

5. Select one of the following options:
   - Select the Stop option to set the product to stop printing (including printing faxes) until you replace the cartridge.
   - Select the Prompt to continue option to set the product to stop printing (including printing faxes) and prompt you to replace the cartridge. You can acknowledge the prompt and continue printing.
   - Select the Continue option to set the product to alert you that the cartridge is very low but to continue printing.

   **NOTE:** Using the Continue setting allows printing beyond Very Low without customer interaction and can result in unsatisfactory print quality.

If you select the Stop or Prompt to continue option, the product stops printing when it reaches the Very Low threshold. When you replace the cartridge, the product automatically resumes printing.

When the product is set to the Stop or Prompt to continue option, there is some risk that faxes will not print when the product resumes printing. This can occur if the product has received more faxes than the memory can hold while the product is waiting.

The product can print faxes without interruption when it passes the Very Low threshold if you select the Continue option for color and black cartridges, but print quality might degrade.

Once an HP supply has reached Very Low, HP's premium Protection Warranty on that supply has ended.
Customer self-repair parts

The following customer self-repair parts are available for the product.

- Parts listed as **Mandatory** self-replacement are to be installed by customers, unless you are willing to pay HP service personnel to perform the repair. For these parts, on-site or return-to-depot support is not provided under the HP product warranty.

- Parts listed as **Optional** self-replacement can be installed by HP service personnel at your request for no additional charge during the product warranty period.

**NOTE:** For more information, go to [www.hp.com/go/customerselfrepair/lj700M712](http://www.hp.com/go/customerselfrepair/lj700M712).

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Self-replacement options</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hard disk drive kit</td>
<td>Replacement 320 GB HP High-Performance Secure Hard Disk</td>
<td>Optional</td>
<td>CF235-67901</td>
</tr>
<tr>
<td></td>
<td>Replacement 320 GB HP High-Performance Secure Hard Disk (Government option)</td>
<td>Optional</td>
<td>CF235-67920</td>
</tr>
<tr>
<td>Formatter assembly kit</td>
<td>Replacement formatter assembly kit</td>
<td>Mandatory</td>
<td>CF235-67902</td>
</tr>
<tr>
<td></td>
<td>Replacement formatter assembly kit—China</td>
<td>Mandatory</td>
<td>CF235-67903</td>
</tr>
<tr>
<td>Solid-state memory (SSM) module</td>
<td>Replacement memory module, 16 GB</td>
<td>Optional</td>
<td>CF235-67904</td>
</tr>
<tr>
<td>DIMM memory</td>
<td>Replacement 512 MB DIMM memory</td>
<td>Mandatory</td>
<td>CF235-67919</td>
</tr>
<tr>
<td>Tray 1 pickup roller/separation pad kit</td>
<td>Replacement pickup roller and separation pad for Tray 1</td>
<td>Optional</td>
<td>CF235-67906</td>
</tr>
<tr>
<td>Tray 2 and Tray 3 pickup roller/separation pad kit</td>
<td>Replacement pickup roller and separation pad for Tray 2 or Tray 3</td>
<td>Optional</td>
<td>CF235-67909</td>
</tr>
<tr>
<td>Tray 2 assembly kit</td>
<td>Replacement for Tray 2</td>
<td>Mandatory</td>
<td>CF235-67911</td>
</tr>
<tr>
<td>Tray 3 assembly kit</td>
<td>Replacement for Tray 3</td>
<td>Mandatory</td>
<td>CF235-67912</td>
</tr>
<tr>
<td>1x500-sheet feeder</td>
<td>Replacement 1x500-sheet feeder</td>
<td>Mandatory</td>
<td>CF235-67914</td>
</tr>
<tr>
<td>Tray 3, 4, 5, and 6 roller kit</td>
<td>Replacement pickup, feed, and separation rollers for Trays 3, 4, 5, and 6</td>
<td>Mandatory</td>
<td>CE710-69008</td>
</tr>
<tr>
<td>Tray 4, 5, or 6 assembly kit</td>
<td>Tray assembly</td>
<td>Mandatory</td>
<td>CF235-67917</td>
</tr>
<tr>
<td>1x500-sheet feeder with stand kit</td>
<td>Optional 500-sheet feeder with stand</td>
<td>Mandatory</td>
<td>CF235-67915</td>
</tr>
<tr>
<td>3x500-sheet feeder with stand kit</td>
<td>Optional 3x500-sheet feeder with stand</td>
<td>Mandatory</td>
<td>CF235-67916</td>
</tr>
<tr>
<td>3,500-sheet high-capacity input feeder with stand kit</td>
<td>Optional 3,500-sheet high-capacity input feeder with stand</td>
<td>Mandatory</td>
<td>CF235-67918</td>
</tr>
<tr>
<td>3,500-sheet high-capacity input feeder left tray assembly</td>
<td>Left tray for the 3,500-sheet high-capacity input feeder</td>
<td>Mandatory</td>
<td>CF235-60103</td>
</tr>
<tr>
<td>3,500-sheet high-capacity input feeder right tray assembly</td>
<td>Right tray for the 3,500-sheet high-capacity input feeder</td>
<td>Mandatory</td>
<td>CF235-60104</td>
</tr>
<tr>
<td>3,500-sheet tray roller kit</td>
<td>Replacement pickup, feed, and separation rollers for the 3,500-sheet high-capacity input feeder</td>
<td>Mandatory</td>
<td>5851-5011</td>
</tr>
<tr>
<td>Transfer-roller kit</td>
<td>Replacement transfer roller</td>
<td>Mandatory</td>
<td>CF235-67910</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
<td>Self-replacement options</td>
<td>Part number</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
<td>--------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Duplexer kit</td>
<td>Optional duplexer kit</td>
<td>Mandatory</td>
<td>CF235-67913</td>
</tr>
<tr>
<td>Fuser assembly kit (110V)</td>
<td>Replacement 110V fuser assembly kit</td>
<td>Mandatory</td>
<td>CF235-67921</td>
</tr>
<tr>
<td>Fuser assembly kit (220V)</td>
<td>Replacement 220V fuser assembly kit</td>
<td>Mandatory</td>
<td>CF235-67922</td>
</tr>
<tr>
<td>Maintenance kit (110V)</td>
<td>Product maintenance kit</td>
<td>Mandatory</td>
<td>CF235-67907</td>
</tr>
<tr>
<td>Maintenance kit (220V)</td>
<td>Product maintenance kit</td>
<td>Mandatory</td>
<td>CF235-67908</td>
</tr>
<tr>
<td>Trays 3, 4, 5, and 6 label kit</td>
<td>Replacement labels for Trays 3, 4, 5, and 6</td>
<td>Mandatory</td>
<td>CE707-00001</td>
</tr>
<tr>
<td>Toner cartridge</td>
<td>Standard capacity</td>
<td>Mandatory</td>
<td>CF214-67901</td>
</tr>
<tr>
<td>Power cable 220V – 10A</td>
<td>Replacement cable – China</td>
<td>Mandatory</td>
<td>B121-0943</td>
</tr>
<tr>
<td>Power cable 110V – 13A</td>
<td>Replacement cable – Taiwan</td>
<td>Mandatory</td>
<td>B121-0964</td>
</tr>
<tr>
<td>Power cable 220V – 10A</td>
<td>Replacement cable – Korea, EU generic</td>
<td>Mandatory</td>
<td>B121-0731</td>
</tr>
<tr>
<td>Power cable 110V – 12A</td>
<td>Replacement cable – Japan</td>
<td>Mandatory</td>
<td>B121-1143</td>
</tr>
<tr>
<td>Power cable 220V – 6A</td>
<td>Replacement cable – India</td>
<td>Mandatory</td>
<td>B121-0564</td>
</tr>
<tr>
<td>Power cable 220V – 10A</td>
<td>Replacement cable – UK/Asia Pacific</td>
<td>Mandatory</td>
<td>B121-0739</td>
</tr>
<tr>
<td>Power cable 220V – 10A</td>
<td>Replacement cable – Australia/New Zealand</td>
<td>Mandatory</td>
<td>B121-0837</td>
</tr>
<tr>
<td>Power cable 220V – 10A</td>
<td>Replacement cable – Israel</td>
<td>Mandatory</td>
<td>B121-1004</td>
</tr>
<tr>
<td>Power cable 220V – 10A</td>
<td>Replacement cable – Denmark</td>
<td>Mandatory</td>
<td>B121-0733</td>
</tr>
<tr>
<td>Power cable 220V – 10A</td>
<td>Replacement cable – South Africa</td>
<td>Mandatory</td>
<td>B121-0737</td>
</tr>
<tr>
<td>Power cable 220V – 10A</td>
<td>Replacement cable – Switzerland</td>
<td>Mandatory</td>
<td>B121-0738</td>
</tr>
<tr>
<td>Power cable 110V – 10A Brazil</td>
<td>Replacement cable – Brazil</td>
<td>Mandatory</td>
<td>B121-1071</td>
</tr>
<tr>
<td>Power cable 220V – 10A Argentina</td>
<td>Replacement cable – Argentina</td>
<td>Mandatory</td>
<td>B121-0729</td>
</tr>
<tr>
<td>Power cable 110V – 13A North America</td>
<td>Replacement cable – North America</td>
<td>Mandatory</td>
<td>B121-0740</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
<td>Self-replacement options</td>
<td>Part number</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
<td>--------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Power cable 220V – 10A South America/Chile/Peru</td>
<td>Replacement cable – South America/Chile/Peru</td>
<td>Mandatory</td>
<td>8121-0735</td>
</tr>
<tr>
<td>Power cable 220V / 110V – Thailand/Philippines</td>
<td>Replacement cable – Thailand/Philippines</td>
<td>Mandatory</td>
<td>8121-0734</td>
</tr>
</tbody>
</table>
## Accessories

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>500-sheet tray and feeder unit</td>
<td>Optional tray to increase paper capacity</td>
<td>CF239A</td>
</tr>
<tr>
<td>1x500-sheet feeder, cabinet, and stand</td>
<td>Optional tray to increase paper capacity</td>
<td>CF243A</td>
</tr>
<tr>
<td>3x500-sheet feeder and stand</td>
<td>Optional tray to increase paper capacity</td>
<td>CF242A</td>
</tr>
<tr>
<td>3,500-sheet high-capacity input and stand</td>
<td>Optional tray to increase paper capacity</td>
<td>CF245A</td>
</tr>
<tr>
<td>Duplex printing assembly</td>
<td>Optional accessory to print on both sides of the paper</td>
<td>CF240A</td>
</tr>
<tr>
<td>HP Jetdirect print servers</td>
<td>HP Jetdirect ew2500 Wireless Print Server</td>
<td>J8021A</td>
</tr>
<tr>
<td></td>
<td>HP Jetdirect 2700w USB Wireless Print Server</td>
<td>J8026A</td>
</tr>
<tr>
<td>USB cable</td>
<td>Standard USB-compatible device connector, 2 m (6.5 ft)</td>
<td>C6518A</td>
</tr>
<tr>
<td>DIMM memory</td>
<td>Optional 512 MB DIMM memory</td>
<td>CE483A</td>
</tr>
</tbody>
</table>
Toner cartridge

Toner-cartridge view

1. Imaging drum

**CAUTION:** Do not touch the shutter or the surface of the roller. Doing so can damage the cartridge.

2. Memory chip

3. Pull-tab for the sealing tape
Toner-cartridge information

Continue printing with the current cartridge until redistributing the toner no longer yields acceptable print quality. To redistribute the toner, remove the toner cartridge from the printer and gently rock the cartridge back and forth about its horizontal axis. For graphical representation, see cartridge replacement instructions. Reinsert the toner cartridge into the printer and close the cover.

<table>
<thead>
<tr>
<th>Capacity</th>
<th>Cartridge number</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard-capacity replacement black toner cartridge</td>
<td>14A</td>
<td>CF214A</td>
</tr>
<tr>
<td>High-capacity replacement black toner cartridge</td>
<td>14X</td>
<td>CF214X</td>
</tr>
</tbody>
</table>

For more information about supplies, go to [www.hp.com/go/learnaboutsupplies](http://www.hp.com/go/learnaboutsupplies).

The information contained herein is subject to change without notice. For the latest supplies information go to [www.hp.com/go/lj700M712_manuals](http://www.hp.com/go/lj700M712_manuals).

Recycle the toner cartridge

To recycle a genuine HP toner cartridge, place the used cartridge in the box in which the new cartridge arrived. Use the enclosed return label to send the used supply to HP for recycling. For complete information, see the recycling guide that is included with each new HP supply item.

Toner-cartridge storage

Do not remove the toner cartridge from its package until you are ready to use it.

⚠️ **CAUTION:** To prevent damage to the toner cartridge, do not expose it to light for more than a few minutes.

HP policy on non-HP toner cartridges

HP Company cannot recommend the use of non-HP toner cartridges, either new or remanufactured.

⚠️ **NOTE:** Any damage caused by a non-HP toner cartridge is not covered under the HP warranty and service agreements.
Replace the toner cartridge

⚠️ **CAUTION:** If toner gets on clothing, wipe it off with a dry cloth and wash the clothes in cold water. Hot water sets toner into fabric.

🔍 **NOTE:** Information about recycling used toner cartridges is on the toner-cartridge box.

1. Press the cartridge-door-release button.

2. Open the cartridge door.
3. Remove the used toner cartridge from the product.

4. Remove the new toner cartridge from the bag. Place the used toner cartridge in the bag for recycling.

5. Grasp the front and back of the toner cartridge, and distribute the toner by gently rocking the toner cartridge five or six times.

   **CAUTION:** Do not touch the shutter or the surface of the roller.
6. Remove the shipping tape from the new toner cartridge. Recycle the tape with the used toner cartridge.

7. Align the toner cartridge with the tracks inside the product, and insert the toner cartridge until it is firmly seated.

8. Close the cartridge door. After a short time, the control panel should display the **Ready** message.
5 Print

- Supported print drivers (Windows)
- Change print-job settings (Windows)
- Change print-job settings (Mac OS X)
- Print tasks (Windows)
- Print tasks (Mac OS X)
- Additional print tasks (Windows)
- Additional print tasks (Mac OS X)
- Store print jobs on the product
- Add a job-separator page (Windows)
- Use HP ePrint
- Use the HP ePrint Mobile Driver
- Use Apple AirPrint
- Use HP Smart Print (Windows)
- Use easy-access USB printing
Supported print drivers (Windows)

Print drivers provide access to the product features and allow the computer to communicate with the product (using a printer language). The following print drivers are available at www.hp.com/go/lj700M712_software.

<table>
<thead>
<tr>
<th>Print Driver</th>
<th>Description</th>
</tr>
</thead>
</table>
| **HP PCL 6 driver**  | ● Provided as the default driver on the in-box CD. This driver is automatically installed unless you select a different one.  
                       ● Recommended for all Windows environments  
                       ● Provides the overall best speed, print quality, and product-feature support for most users  
                       ● Developed to align with the Windows Graphic Device Interface (GDI) for the best speed in Windows environments  
                       ● Might not be fully compatible with third-party and custom software programs that are based on PCL 5 |
| **HP UPD PS driver** | ● Recommended for printing with Adobe® software programs or with other highly graphics-intensive software programs  
                       ● Provides support for printing from postscript emulation needs, or for postscript flash font support |
| **HP UPD PCL 5**     | ● Recommended for general office printing in Windows environments  
                       ● Compatible with previous PCL versions and older HP LaserJet products  
                       ● The best choice for printing from third-party or custom software programs  
                       ● The best choice when operating with mixed environments, which require the product to be set to PCL 5 (UNIX, Linux, mainframe)  
                       ● Designed for use in corporate Windows environments to provide a single driver for use with multiple product models  
                       ● Preferred when printing to multiple product models from a mobile Windows computer |
| **HP UPD PCL 6**     | ● Recommended for printing in all Windows environments  
                       ● Provides the overall best speed, print quality, and printer feature support for most users  
                       ● Developed to align with Windows Graphic Device Interface (GDI) for best speed in Windows environments  
                       ● Might not be fully compatible with third-party and custom software programs that are based on PCL 5 |

**HP Universal Print Driver (UPD)**

The HP Universal Print Driver (UPD) for Windows is a single print driver that gives you instant access to virtually any HP LaserJet product, from any location, without downloading separate drivers. It is built on proven HP print driver technology and has been tested thoroughly and used with many software programs. It is a powerful solution that performs consistently over time.

The HP UPD communicates directly with each HP product, gathers configuration information, and then customizes the user interface to show the product’s unique, available features. It automatically enables features that are available for the product, such as two-sided printing and stapling, so you do not need to enable them manually.
For more information, go to [www.hp.com/go/upd](http://www.hp.com/go/upd).

## UPD installation modes

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
</table>
| Traditional   | ● To use this mode, download UPD from the Internet. Go to [www.hp.com/go/upd](http://www.hp.com/go/upd).  
                 ● Use this mode if you are installing the driver for a single computer.  
                 ● It operates with a specific product.  
                 ● If you use this mode, you must install UPD separately for each computer and for each product. |
| Dynamic       | ● To use this mode, download UPD from the Internet. Go to [www.hp.com/go/upd](http://www.hp.com/go/upd).  
                 ● Dynamic mode allows you to use a single driver installation, so you can discover and print to HP products in any location.  
                 ● Use this mode if you are installing UPD for a workgroup. |
Change print-job settings (Windows)

Change the settings for all print jobs until the software program is closed

The steps can vary; this procedure is most common.

1. From the software program, select the Print option.
2. Select the product, and then click Properties or Preferences.

Change the default settings for all print jobs

1. **Windows XP, Windows Server 2003, and Windows Server 2008 (using the default Start menu view):** Click Start, and then click Printers and Faxes.
   
   **Windows XP, Windows Server 2003, and Windows Server 2008 (using the Classic Start menu view):** Click Start, click Settings, and then click Printers.

   **Windows Vista:** Click the Windows icon in the lower-left corner of the screen, click Control Panel, and then click Printers.

   **Windows 7:** Click the Windows icon in the lower-left corner of the screen, and then click Devices and Printers.

2. Right-click the print-driver icon, and then select Printing Preferences.

Change the product configuration settings

1. **Windows XP, Windows Server 2003, and Windows Server 2008 (using the default Start menu view):** Click Start, and then click Printers and Faxes.

   **Windows XP, Windows Server 2003, and Windows Server 2008 (using the Classic Start menu view):** Click Start, click Settings, and then click Printers.

   **Windows Vista:** Click the Windows icon in the lower-left corner of the screen, click Control Panel, and then click Printers.

   **Windows 7:** Click the Windows icon in the lower-left corner of the screen, and then click Devices and Printers.

2. Right-click the print-driver icon, and then select Properties or Printer properties.
3. Click the Device Settings tab.
Change print-job settings (Mac OS X)

Change the settings for all print jobs until the software program is closed

1. Click the File menu, and then click the Print option.
2. In the Printer menu, select the product.
3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list, and then open a menu for which you want to change the print settings.
4. For each menu, select the print settings that you want to change.
5. Change the settings that you want on the various menus.

Change the default settings for all print jobs

1. Click the File menu, and then click the Print option.
2. In the Printer menu, select the product.
3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list, and then open a menu for which you want to change the print settings.
4. For each menu, select the print settings that you want to save for reuse.
5. In the Presets menu, click the Save As... option, and enter a name for the preset.
6. Click the OK button.

These settings are saved in the Presets menu. To use the new settings, you must select the saved preset option every time you open a program and print.

Change the product configuration settings

1. At the computer, open the Apple menu, click the System Preferences menu, and then click the Print & Fax icon (OS X v10.5 and 10.6) or the Print & Scan icon (OS X v10.7).
2. Select the product in the left side of the window.
3. Click the Options & Supplies button.
4. Click the Driver tab.
5. Configure the installed options.
Print tasks (Windows)

Use a printing shortcut (Windows)

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Printing Shortcuts tab.
4. Select one of the shortcuts. Click the **OK** button to close the **Document Properties** dialog box.

   **NOTE:** When you select a shortcut, the corresponding settings change on the other tabs in the print driver.

5. In the **Print** dialog box, click the **OK** button to print the job.
Create printing shortcuts (Windows)

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Printing Shortcuts tab.

4. Select an existing shortcut as a base.

   **NOTE:** Always select a shortcut before adjusting any of the settings on the right side of the screen. If you adjust the settings and then select a shortcut, all your adjustments are lost.
5. Select the print options for the new shortcut.

6. Click the **Save As** button.
7. Enter a name for the shortcut, and then click the **OK** button.

8. Click the **OK** button to close the **Document Properties** dialog box. In the **Print** dialog box, click the **OK** button to print the job.
Automatically print on both sides (Windows)

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Finishing tab.
4. Select the Print on both sides check box. Click the OK button to close the Document Properties dialog box.

5. In the Print dialog box, click the OK button to print the job.
Manually print on both sides (Windows)

1. From the software program, select the **Print** option.

2. Select the product, and then click the **Properties** or **Preferences** button.

3. Click the **Finishing** tab.
4. Select the **Print on both sides (manually)** check box. Click the **OK** button to print the first side of the job.

5. Retrieve the printed stack from the output bin, and place it with the printed-side facing down in Tray 1.

6. If prompted, touch the appropriate control panel button to continue.
Print multiple pages per sheet (Windows)

1. From the software program, select the **Print** option.

2. Select the product, and then click the **Properties** or **Preferences** button.

3. Click the **Finishing** tab.
4. Select the number of pages per sheet from the **Pages per sheet** drop-down list.

5. Select the correct **Print page borders**, **Page order**, and **Orientation** options. Click the **OK** button to close the **Document Properties** dialog box.

6. In the **Print** dialog box, click the **OK** button to print the job.
Select the page orientation (Windows)

1. From the software program, select the **Print** option.

2. Select the product, and then click the **Properties** or **Preferences** button.

3. Click the **Finishing** tab.
4. In the Orientation area, select the Portrait or Landscape option.

To print the page image upside down, select the Rotate by 180 degrees option.

Click the OK button to close the Document Properties dialog box.

5. In the Print dialog box, click the OK button to print the job.
Select the paper type (Windows)

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. From the Paper type drop-down list, click the More... option.
5. Expand the list of **Type is:** options.

6. Expand the category of paper types that best describes your paper.
7. Select the option for the type of paper you are using, and click the **OK** button.

8. Click the **OK** button to close the **Document Properties** dialog box. In the **Print** dialog box, click the **OK** button to print the job.
Print the first or last page on different paper (Windows)

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. In the Special pages area, click the Print pages on different paper option, and then click the Settings button.
5. In the Pages in document area, select either the First or Last option.

6. Select the correct options from the Paper source and Paper type drop-down lists. Click the Add button.

7. If you are printing both the first and last pages on different paper, repeat steps 5 and 6, selecting the options for the other page.
8. Click the **OK** button.

9. Click the **OK** button to close the **Document Properties** dialog box. In the **Print** dialog box, click the **OK** button to print the job.
Scale a document to fit page size (Windows)

1. From the software program, select the **Print** option.

2. Select the product, and then click the **Properties** or **Preferences** button.

3. Click the **Effects** tab.
4. Select the **Print document on** option, and then select a size from the drop-down list.

   Click the **OK** button to close the **Document Properties** dialog box.

5. In the **Print** dialog box, click the **OK** button to print the job.
Create a booklet (Windows)

1. From the software program, select the **Print** option.
2. Select the product, and then click the **Properties** or **Preferences** button.
3. Click the **Finishing** tab.
4. Select the **Print on both sides** check box.
5. In the Booklet layout drop-down list, click the Left binding or Right binding option. The Pages per sheet option automatically changes to 2 pages per sheet.

Click the OK button to close the Document Properties dialog box.

6. In the Print dialog box, click the OK button to print the job.
Print tasks (Mac OS X)

Use a printing preset (Mac OS X)

1. Click the **File** menu, and then click the **Print** option.
2. In the **Printer** menu, select the product.
3. In the **Presets** menu, select the printing preset.
4. Click the **Print** button.

**NOTE:** To use print-driver default settings, select the **standard** option.

Create a printing preset (Mac OS X)

Use printing presets to save the current print settings for reuse.

1. Click the **File** menu, and then click the **Print** option.
2. In the **Printer** menu, select the product.
3. By default, the print driver displays the **Copies & Pages** menu. Open the menus drop-down list, and then open a menu for which you want to change the print settings.
4. For each menu, select the print settings that you want to save for reuse.
5. In the **Presets** menu, click the **Save As...** option, and enter a name for the preset.
6. Click the **OK** button.

Automatically print on both sides (Mac OS X)

1. Click the **File** menu, and then click the **Print** option.
2. In the **Printer** menu, select the product.
3. By default, the print driver displays the **Copies & Pages** menu. Open the menus drop-down list, and then click the **Layout** menu.
4. Select a binding option from the **Two-Sided** drop-down list.
5. Click the **Print** button.

Manually print on both sides (Mac OS X)

1. Click the **File** menu, and then click the **Print** option.
2. In the **Printer** menu, select this product.
3. Open the **Manual Duplex** menu.
4. Click the **Manual Duplex** box, and select a binding option.
5. Click the **Print** button.

6. Go to the product, and remove any blank paper that is in Tray 1.

7. Retrieve the printed stack from the output bin and place it with the printed-side facing down in the input tray.

8. If prompted, press the appropriate control panel button to continue.

### Print multiple pages per sheet (Mac OS X)

1. Click the **File** menu, and then click the **Print** option.

2. In the **Printer** menu, select the product.

3. By default, the print driver displays the **Copies & Pages** menu. Open the menus drop-down list, and then click the **Layout** menu.

4. From the **Pages per Sheet** drop-down list, select the number of pages that you want to print on each sheet.

5. In the **Layout Direction** area, select the order and placement of the pages on the sheet.

6. From the **Border** menu, select the type of border to print around each page on the sheet.

7. Click the **Print** button.

### Select the page orientation (Mac OS X)

1. Click the **File** menu, and then click the **Print** option.

2. In the **Printer** menu, select the product.

3. In the **Copies & Pages** menu, click the **Page Setup** button.

4. Click the icon that represents the page orientation that you want to use, and then click the **OK** button.

5. Click the **Print** button.

### Select the paper type (Mac OS X)

1. Click the **File** menu, and then click the **Print** option.

2. In the **Printer** menu, select the product.

3. By default, the print driver displays the **Copies & Pages** menu. Open the menus drop-down list, and then click the **Finishing** menu.

4. Select a type from the **MediaType** drop-down list.

5. Click the **Print** button.
Print a cover page (Mac OS X)

1. Click the File menu, and then click the Print option.
2. In the Printer menu, select the product.
3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list, and then click the Cover Page menu.
4. Select where to print the cover page. Click either the Before Document button or the After Document button.
5. In the Cover Page Type menu, select the message that you want to print on the cover page.

NOTE: To print a blank cover page, select the standard option from the Cover Page Type menu.
6. Click the Print button.

Scale a document to fit page size (Mac OS X)

1. Click the File menu, and then click the Print option.
2. In the Printer menu, select the product.
3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list, and then click the Paper Handling menu.
4. In the Destination Paper Size area, click the Scale to fit paper size box, and then select the size from the drop-down list.
5. Click the Print button.

Create a booklet (Mac OS X)

1. Click the File menu, and then click the Print option.
2. In the Printer menu, select the product.
3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list, and then click the Layout menu.
4. Select a binding option from the Two-Sided drop-down list.
5. Open the menus drop-down list, and then click the Booklet Printing menu.
6. Click the Format Output As Booklet box, and select a binding option.
7. Select the paper size.
8. Click the Print button.
Additional print tasks (Windows)

Cancel a print job (Windows)

**NOTE:** If the print job is too far into the printing process, you might not have the option to cancel it.

1. If the print job is currently printing, cancel it from the product control panel by following this procedure:
   a. On the product control panel, press the Stop button.
   b. The product asks you to confirm the deletion. Press the OK button.

2. You can also cancel a print job from a software program or a print queue.
   - **Software program:** Typically, a dialog box is briefly displayed on the computer screen, allowing you to cancel the print job.
   - **Windows print queue:** If a print job is waiting in a print queue (computer memory) or print spooler, delete the job there.
     - **Windows XP, Server 2003, or Server 2008:** Click Start, click Settings, and then click Printers and Faxes. Double-click the product icon to open the window, right-click the print job that you want to cancel, and then click Cancel.
     - **Windows Vista:** Click the Windows icon in the lower left corner of the screen, click Settings, and then click Printers. Double-click the product icon to open the window, right-click the print job that you want to cancel, and then click Cancel.
     - **Windows 7:** Click the Windows icon in the lower left corner of the screen, and then click Devices and Printers. Double-click the product icon to open the window, right-click the print job that you want to cancel, and then click Cancel.

Select the paper size (Windows)

1. From the software program, select the Print option.
2. Select the product, and then click the Properties or Preferences button.
3. Click the Paper/Quality tab.
4. Select a size from the Paper size drop-down list.
5. Click the OK button.
6. In the Print dialog box, click the OK button to print the job.

Select a custom paper size (Windows)

1. From the software program, select the Print option.
2. Select the product, and then click the Properties or Preferences button.
3. Click the Paper/Quality tab.
4. Click the Custom button.
5. Type a name for the custom size and specify the dimensions.
   - The width is the short edge of the paper.
   - The length is the long edge of the paper.

6. Click the Save button, and then click the Close button.

7. Click the OK button to close the Document Properties dialog box. In the Print dialog box, click the OK button to print the job.

Print watermarks (Windows)

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Effects tab.

4. Select a watermark from the Watermarks drop-down list.
   - Or, to add a new watermark to the list, click the Edit button. Specify the settings for the watermark, and then click the OK button.

5. To print the watermark on the first page only, select the First page only check box. Otherwise, the watermark is printed on each page.

6. Click the OK button to close the Document Properties dialog box. In the Print dialog box, click the OK button to print the job.
Additional print tasks (Mac OS X)

Cancel a print job (Mac OS X)

NOTE: If the print job is too far into the printing process, you might not have the option to cancel it.

1. If the print job is currently printing, cancel it from the product control panel by following this procedure:
   a. On the product control panel, press the Stop button.
   b. The product asks you to confirm the deletion. Press the OK button.

2. You can also cancel a print job from a software program or a print queue.
   - Software program: Typically, a dialog box appears briefly on the computer screen, allowing you to cancel the print job.
   - Mac print queue: Open the print queue by double-clicking the product icon in the dock. Highlight the print job, and then click Delete.

Select the paper size (Mac OS X)

1. Click the File menu, and then click the Print option.
2. In the Printer menu, select the product.
3. In the Copies & Pages menu, click the Page Setup button.
4. Select a size from the Paper Size drop-down list, and then click the OK button.
5. Click the Print button.

Select a custom paper size (Mac OS X)

1. Click the File menu, and then click the Print option.
2. In the Printer menu, select the product.
3. In the Copies & Pages menu, click the Page Setup button.
4. From the Paper Size drop-down list, select the Manage Custom Sizes option.
5. Specify the dimensions for the page size, and then click the OK button.
6. Click the OK button to close the Page Setup dialog.
7. Click the Print button.

Print watermarks (Mac OS X)

1. Click the File menu, and then click the Print option.
2. In the Printer menu, select the product.
3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list, and then click the Watermarks menu.
4. From the **Mode** menu, select the **Watermark** option.

5. From the **Pages** drop-down list, select whether to print the watermark on all pages or on the first page only.

6. From the **Text** drop-down list, select one of the standard messages, or select the **Custom** option and type a new message in the box.

7. Select options for the remaining settings.

8. Click the **Print** button.
Store print jobs on the product

Create a stored job (Windows)

You can store jobs on the product so you can print them at any time.

1. From the software program, select the **Print** option.

2. Select the product, and then click the **Properties** or **Preferences** button.

3. Click the **Job Storage** tab.
4. Select a **Job Storage Mode** option.

- **Proof and Hold**: Print and proof one copy of a job and then print more copies.

- **Personal Job**: The job does not print until you request it at the product control panel. For this job-storage mode, you can select one of the **Make Job Private/Secure** options. If you assign a personal identification number (PIN) to the job, you must provide the required PIN at the control panel. If you encrypt the job, you must provide the required password at the control panel.

- **Quick Copy**: Print the requested number of copies of a job and then store a copy of the job in the product memory so you can print it again later.

- **Stored Job**: Store a job on the product and allow other users to print the job at any time. For this job-storage mode, you can select one of the **Make Job Private/Secure** options. If you assign a personal identification number (PIN) to the job, the person who prints the job must provide the required PIN at the control panel. If you encrypt the job, the person who prints the job must provide the required password at the control panel.
5. To use a custom user name or job name, click the **Custom** button, and then enter the user name or the job name.

Select which option to use if another stored job already has that name:

- **Use Job Name + (1-99)**: Append a unique number to the end of the job name.
- **Replace Existing File**: Overwrite the existing stored job with the new one.

6. Click the **OK** button to close the Document Properties dialog box. In the Print dialog box, click the **OK** button to print the job.

---

**Create a stored job (Mac OS X)**

You can store jobs on the product so you can print them at any time.

1. Click the **File** menu, and then click the **Print** option.
2. In the **Printer** menu, select the product.
3. By default, the print driver displays the **Copies & Pages** menu. Open the menus drop-down list, and then click the **Job Storage** menu.
4. In the **Mode** drop-down list, select the type of stored job.
   - **Proof and Hold**: Print and proof one copy of a job and then print more copies.
   - **Personal Job**: The job does not print until you request it at the product control panel. If you assign a personal identification number (PIN) to the job, you must provide the required PIN at the control panel.
- **Quick Copy**: Print the requested number of copies of a job and then store a copy of the job in the product memory so you can print it again later.

- **Stored Job**: Store a job on the product and allow other users to print the job at any time. If you assign a personal identification number (PIN) to the job, the person who prints the job must provide the required PIN at the control panel.

5. To use a custom user name or job name, click the Custom button, and then enter the user name or the job name.

Select which option to use if another stored job already has that name.

<table>
<thead>
<tr>
<th>Use Job Name + (1 – 99)</th>
<th>Append a unique number to the end of the job name.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replace Existing File</td>
<td>Overwrite the existing stored job with the new one.</td>
</tr>
</tbody>
</table>

6. If you selected the Stored Job or Personal Job option in step 3, you can protect the job with a PIN. Type a 4-digit number in the Use PIN to Print field. When other people attempt to print this job, the product prompts them to enter this PIN number.

7. Click the Print button to process the job.

**Print a stored job**

Use the following procedure to print a job that is stored in the product memory.

1. On the product control panel, press the Home button.

2. Highlight the Retrieve from Device Memory item, and then press the OK button.

3. Highlight the name of the folder where the job is stored, and then press the OK button.

4. Highlight the name of the job, and then press the OK button. If the job is private or encrypted, enter the PIN or password.

5. Adjust the number of copies, and then press the OK button to print the job.

**Delete a stored job**

When you send a stored job to the product memory, the product overwrites any previous jobs with the same user and job name. If a job is not already stored under the same user and job name, and the product needs additional space, the product might delete other stored jobs starting with the oldest. You can change the number of jobs that the product can store from the General Settings menu on the product control panel.

Use this procedure to delete a job that is stored in the product memory.

1. On the product control panel, press the Home button.

2. Highlight the Retrieve from Device Memory option, and then press the OK button.

3. Select the name of the folder where the job is stored.

4. Select the name of the job, and then press the OK button.

5. If the job is private or encrypted, enter the PIN or the password, and then press the OK button.

6. Highlight the Delete option, and then press the OK button.
Add a job-separator page (Windows)

The product can insert a blank page at the beginning of each print job to make sorting jobs easier.

**NOTE:** The following procedure turns on this setting for all print jobs.

1. **Windows XP, Windows Server 2003, and Windows Server 2008 (using the default Start menu view):** Click **Start**, and then click **Printers and Faxes**.

   **Windows XP, Windows Server 2003, and Windows Server 2008 (using the Classic Start menu view):** Click **Start**, click **Settings**, and then click **Printers**.

   **Windows Vista:** Click the Windows icon in the lower-left corner of the screen, click **Control Panel**, and then click **Printers**.

   **Windows 7:** Click the Windows icon in the lower-left corner of the screen, and then click **Devices and Printers**.

2. Right-click the driver icon, and then select **Properties** or **Printer properties**.

3. Click the **Device Settings** tab.

4. Expand the **Installable Options** list.

5. In the **Job Separator** drop-down list, select the **Enabled** option.

6. Click the **OK** button.
Use HP ePrint

Use HP ePrint to print a document by sending it as an email attachment to the product's email address from any email-enabled device.

**NOTE:** The product must be connected to a network and have Internet access to use HP ePrint.

1. To use HP ePrint, you must first enable HP Web Services.
   a. Type the product IP address into the address line of a Web browser to open the HP Embedded Web Server.
   b. Click the **HP Web Services** tab.
   c. Select the option to enable Web Services.

   **NOTE:** Enabling Web Services might take several minutes.

2. Use the HP ePrintCenter Web site to define security settings and to configure default print settings for all HP ePrint jobs sent to this product.
   a. Go to [www.hpeprintcenter.com](http://www.hpeprintcenter.com).
   b. Click **Sign In**, and enter your HP ePrintCenter credentials or sign up for a new account.
   c. Select your product from the list, or click **+ Add printer** to add it. To add the product, you need the printer code, which is the segment of the product email address that is before the @ symbol.

   **NOTE:** This code is valid for only 24 hours from the time you enable HP Web Services. If it expires, follow the instructions to enable HP Web Services again, and obtain a new code.

   d. To prevent your product from printing unexpected documents, click **ePrint Settings**, and then click the **Allowed Senders** tab. Click **Allowed Senders Only**, and add the email addresses from which you want to allow ePrint jobs.

   e. To set up default settings for all ePrint jobs sent to this product, click **ePrint Settings**, click **Print Options**, and select the settings that you want to use.

3. To print a document, attach it to an email message sent to the product's email address.
Use the HP ePrint Mobile Driver

The HP ePrint Mobile Driver makes it easy to print from a desktop or laptop computer to any HP ePrint-capable product. After installing the driver, open the Print option from within your application, and then select **HP ePrint Mobile** from the installed printers list. This single driver makes it easy to find HP ePrint-enabled products that are registered to your ePrintCenter account. The target HP product can be at your desk or in a remote location, such as a branch office or across the globe—you can do remote printing by using the Internet. The target product can be anywhere in the world; if it is Web-connected and registered in ePrintCenter, you can send a print job to the product.

For Windows, the HP ePrint Mobile Driver also supports traditional direct IP printing to local network printers on the network (LAN or WAN) to supported PostScript® products.

Go to [www.hp.com/go/eprintmobiledriver](http://www.hp.com/go/eprintmobiledriver) for drivers and information.

**Supported operating systems**

- Windows® XP (32-bit, SP 2 or greater)

  **NOTE:** Microsoft retired mainstream support for Windows XP in April 2009. HP will continue to provide best-effort support for the discontinued XP operating system.

- Windows Vista® (32-bit and 64-bit)

- Windows 7 (32-bit and 64-bit)

- Mac OS X version 10.6, 10.7, and 10.8

  **NOTE:** The HP ePrint Mobile Driver is a PDF workflow utility for Mac, and is not technically a print driver. HP ePrint Mobile for Mac supports print paths only through ePrintCenter and does not support direct IP printing to local network printers.
Use Apple AirPrint

Direct printing using Apple’s AirPrint is supported for iOS 4.2 or later. Use AirPrint to print wirelessly to the product from an iPad (iOS 4.2 or later), iPhone (3GS or later), or iPod touch (third generation or later) in the following applications:

- Mail
- Photos
- Safari
- iBooks
- Select third-party applications

Connect the product to AirPrint

To use AirPrint, the product must be connected to the same wireless network as the Apple device. For more information about using AirPrint and about which HP products are compatible with AirPrint, go to www.hp.com/go/airprint.

NOTE: AirPrint does not support USB connections.

You might need to upgrade the product firmware to use AirPrint. Go to www.hp.com/go/lj700M712_firmware.

Find the product AirPrint name

If multiple models of the product are connected to the network, use the AirPrint product name to select the product from the Apple device.

Use the following steps to find the AirPrint product name.

1. On the product control panel, press the Home button.
2. Open the following menus:
   - How to Connect
   - Network Address
3. The AirPrint product name is listed in the network addresses.

Print from AirPrint

1. On an Apple device, open the document you want to print, and then tap the Action button.
2. Tap the Print option.

   NOTE: If you are using iOS 5 or later and printing photos, the option to select the paper size appears if more than one tray is loaded with paper.

3. Select the product.
4. Tap the Print button.
**Change the AirPrint product name**

1. In a supported Web browser on your computer, enter the product IP address or host name in the address/URL field to open the HP Embedded Web Server.
2. Click the **Networking** tab, click the **TCP/IP Settings** option, and then click the **Network Identification** option.
3. In the **Bonjour Service Name** field, type a new name.
4. Click the **Apply** button.

**Solve AirPrint problems**

<table>
<thead>
<tr>
<th>Task</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make sure the product is connected to the same wireless network as the Apple device.</td>
<td>Connect the product to the network using a wireless router or the wireless accessory installed on the product.</td>
</tr>
</tbody>
</table>
| Verify the HP Embedded Web Server is configured for AirPrint. | 1. In a supported Web browser on your computer, enter the product IP address or host name in the address/URL field to open the HP Embedded Web Server.  
   2. Click the **Networking** tab, and then click the **Other Settings** option.  
   3. Select the following checkboxes:  
      - Bonjour  
      - AirPrint  
      - IPP Printing  
   4. Click the **Apply** button. |
| Make sure the Apple products meet these specifications. | ● Apple iOS 4.2 or later  
   ● iPhone with 3GS or later  
   ● iPad with iOS 4.2 or later  
   ● iPod Touch third generation or later |
| Verify the product is configured so it wakes from Sleep mode whenever it receives a print job. | 1. In a supported Web browser on your computer, enter the product IP address or host name in the address/URL field to open the HP Embedded Web Server.  
   2. Click the **General** tab, and then click the **Energy Settings** option.  
   3. In the **Sleep Timer Settings** area, under the **Wake/Auto On Events** option, select the **All events** item.  
   4. Click the **Apply** button. |
Use HP Smart Print (Windows)

Use HP Smart Print to print a particular section of a Web site. You can remove headers, footers, and advertisements, so you minimize waste. The application automatically selects the section of the Web page that you most likely want to print. You can edit the selected area before you print.

Download HP Smart Print from this Web site: www.hp.com/go/smartweb.

**NOTE:** HP Smart Print is compatible with Windows browsers only.
Use easy-access USB printing

This product features easy-access USB printing, so you can quickly print files from the product control panel without sending them from a computer. The product accepts standard USB flash drives in the USB port on the front of the product. You can print the following types of files:

- .pdf
- .prn
- .pcl
- .ps
- .cht

Before you can use this feature, you must enable the USB port. Use the following procedure to enable the port from the product control-panel menus:

1. On the product control panel, press the Home button.
2. Open the following menus:
   - Administration
   - General Settings
   - Enable Retrieve from USB
3. Highlight the Enable option, and then press the OK button to save the selection.

Configure the following settings so the product wakes from Sleep mode whenever it receives a print job.

1. On the product control panel, press the Home button.
2. Open the following menus:
   - Administration
   - General Settings
   - Energy Settings
   - Sleep Timer Settings
   - Wake/Auto On Events
3. Highlight the All events option and press the OK button.
Print easy-access USB documents

1. Insert the USB flash drive into the USB port on the left side of the product control panel.
   
   **NOTE:** You might need to remove the cover from the USB port.

2. The USB storage device detected screen opens. Select the **OK** option to access the USB device.

3. Highlight the name of the document that you want to print.

4. To adjust the number of copies, use the arrow keys to change the quantity.

5. Press the **OK** button to print the document.
6 Manage the product

- Configure IP network settings
- HP Embedded Web Server
- HP Utility (Mac OS X)
- Use HP Web Jetadmin software
- Economy settings
- Product security features
- Upgrade the product firmware
Configure IP network settings

Printer sharing disclaimer
HP does not support peer-to-peer networking, as the feature is a function of Microsoft operating systems and not of the HP print drivers. Go to Microsoft at www.microsoft.com.

View or change network settings
Use the HP Embedded Web Server to view or change IP configuration settings.

1. Print a configuration page, and locate the IP address.
   - If you are using IPv4, the IP address contains only digits. It has this format:
     
     \text{xxx.xxx.xxx.xxx}
   
   - If you are using IPv6, the IP address is a hexadecimal combination of characters and digits. It has a format similar to this:

     \text{xxxx::xxxx::xxxx::xxxx}

2. To open the HP Embedded Web Server, type the IP address into the address line of a Web browser.
3. Click the Networking tab to obtain network information. You can change settings as needed.

Manually configure IPv4 TCP/IP parameters from the control panel
Use the control-panel Administration menus to manually set an IPv4 address, subnet mask, and default gateway.

1. On the product control panel, press the Home button.
2. Open the following menus:
   
   - Administration
   - Network Settings
   - Jetdirect Menu
   - TCP/IP
   - IPV4 Settings
   - Config Method
3. Highlight the Manual option, and then press the OK button.
4. Highlight the Manual Settings menu, and then press the OK button.
5. Select the IP Address, Subnet Mask, or Default Gateway option.
6. Select the first field to open a keypad. Enter the correct digits for the field, and then press the OK button.
7. Repeat the process for each field, and then press the OK button.
Manually configure IPv6 TCP/IP parameters from the control panel

Use the control-panel Administration menus to manually set an IPv6 address.

1. On the product control panel, press the Home button.

2. To enable manual configuration, open the following menus:
   - Administration
   - Network Settings
   - Jetdirect Menu
   - TCP/IP
   - IPV6 Settings
   - Address
   - Manual Settings
   - Enable

   Select the On option, and then press the OK button.

3. Select the Address option, and then press the OK button to open a keypad.

4. Use the keypad to enter the address.

5. Press the OK button.
HP Embedded Web Server

Use the HP Embedded Web Server to view product status, configure product network settings, and to manage printing functions from your computer instead of from the product control panel. The following are examples of what you can do using the HP Embedded Web Server:

- View product status information
- Determine the remaining life for all supplies and order new ones
- View and change tray configurations
- View and change the product control-panel menu configuration
- View and print internal pages
- Receive notification of product and supplies events
- View and change network configuration

To use the HP Embedded Web Server, your browser must meet the following requirements:

- Windows: Microsoft Internet Explorer 5.01 or later or Netscape 6.2 or later
- Mac OS X: Safari or Firefox using Bonjour or an IP address
- Linux: Netscape Navigator only
- HP-UX 10 and HP-UX 11: Netscape Navigator 4.7

The HP Embedded Web Server works when the product is connected to an IP-based network. The HP Embedded Web Server does not support IPX-based product connections. You do not have to have Internet access to open and use the HP Embedded Web Server.

When the product is connected to the network, the HP Embedded Web Server is automatically available.

Open the HP Embedded Web Server

1. Identify the product IP address or host name. Follow these steps to print or view the product configuration page:
   a. On the product control panel, press the Home button.
   b. Open the following menus:
      - Administration
      - Reports
      - Configuration/Status Pages
      - Configuration Page
   c. Select the Print or View option.
   d. Find the IP address or host name on the Jetdirect page.

2. In a supported Web browser on your computer, enter the product IP address or host name in the address/URL field.
HP Embedded Web Server features

Information tab

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Status</td>
<td>Shows the product status and shows the estimated life remaining of HP supplies. The page also shows the type and size of paper set for each tray. To change the default settings, click the Change Settings link.</td>
</tr>
<tr>
<td>Job Log</td>
<td>Shows a summary of all jobs the product has processed.</td>
</tr>
<tr>
<td>Configuration Page</td>
<td>Shows the information found on the configuration page.</td>
</tr>
<tr>
<td>Supplies Status Page</td>
<td>Shows the status of the supplies for the product.</td>
</tr>
<tr>
<td>Event Log Page</td>
<td>Shows a list of all product events and errors. Use the HP Instant Support link (in the Other Links area on all HP Embedded Web Server pages) to connect to a set of dynamic Web pages that help you solve problems. These pages also show additional services available for the product.</td>
</tr>
<tr>
<td>Usage Page</td>
<td>Shows a summary of the number of pages the product has printed, grouped by size, type, and paper print path.</td>
</tr>
<tr>
<td>Device Information</td>
<td>Shows the product network name, address, and model information. To customize these entries, click the Device Information menu on the General tab.</td>
</tr>
<tr>
<td>Control Panel Snapshot</td>
<td>Shows an image of the current screen on the control-panel display.</td>
</tr>
<tr>
<td>Print</td>
<td>Upload a print-ready file from your computer to print. The product uses the default print settings to print the file.</td>
</tr>
<tr>
<td>Printable Reports and Pages</td>
<td>Lists the internal reports and pages for the product. Select one or more items to print.</td>
</tr>
</tbody>
</table>

General tab

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Panel Customization</td>
<td>Reorder, show, or hide features on the control-panel display, and change the default display language.</td>
</tr>
<tr>
<td>Quick Sets Setup</td>
<td>Configure jobs that are available in the Quick Sets area of the Home screen on the product control panel.</td>
</tr>
<tr>
<td>Alerts</td>
<td>Set up email alerts for various product and supplies events.</td>
</tr>
<tr>
<td>Control Panel Administration Menu</td>
<td>Shows the menu structure of the Administration menu on the control panel.</td>
</tr>
<tr>
<td>AutoSend</td>
<td>Configure the product to send automated emails regarding product configuration and supplies to specific email addresses.</td>
</tr>
<tr>
<td>Edit Other Links</td>
<td>Add or customize a link to another Web site. This link displays in the Other Links area on all HP Embedded Web Server pages.</td>
</tr>
<tr>
<td>Ordering Information</td>
<td>Enter information about ordering replacement toner cartridges. This information displays on the supplies status page.</td>
</tr>
</tbody>
</table>
### Table 6-2  HP Embedded Web Server General tab (continued)

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Information</td>
<td>Name the product and assign an asset number to it. Enter the name of the primary contact who will receive information about the product.</td>
</tr>
<tr>
<td>Language</td>
<td>Set the language in which to display the HP Embedded Web Server information.</td>
</tr>
<tr>
<td>Date and Time</td>
<td>Set the date and time or synchronize with a network time server.</td>
</tr>
<tr>
<td>Energy Settings</td>
<td>Set or edit a wake time, sleep time, and sleep delay for the product. You can set a different schedule for each day of the week and for holidays. You can also set which interactions with the product cause it to wake from sleep mode.</td>
</tr>
<tr>
<td>Backup and Restore</td>
<td>Create a backup file that contains product and user data. If necessary, you can use this file to restore data to the product.</td>
</tr>
<tr>
<td>Restore Factory Settings</td>
<td>Restore product settings to the factory defaults.</td>
</tr>
<tr>
<td>Solution Installer</td>
<td>Install third-party software programs that can enhance the product functionality.</td>
</tr>
<tr>
<td>Firmware Upgrade</td>
<td>Download and install product firmware upgrade files.</td>
</tr>
<tr>
<td>Quota and Statistics Services</td>
<td>Provides connection information about third-party job-statistics services.</td>
</tr>
</tbody>
</table>

### Print tab

**Table 6-3  HP Embedded Web Server Print tab**

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retrieve from USB Setup</td>
<td>Enable or disable the Retrieve from USB menu on the control panel.</td>
</tr>
<tr>
<td>Manage Stored Jobs</td>
<td>Enable or disable the ability to store jobs in the product memory, and configure job-storage options.</td>
</tr>
<tr>
<td>Adjust Paper Types</td>
<td>If print quality problems occur when using a specific paper type, you can override factory-default mode settings.</td>
</tr>
<tr>
<td>General Print Settings</td>
<td>Configure settings for all print jobs.</td>
</tr>
<tr>
<td>Manage Trays</td>
<td>Configure settings for paper trays.</td>
</tr>
</tbody>
</table>

### Troubleshooting tab

**Table 6-4  HP Embedded Web Server Troubleshooting tab**

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Troubleshooting</td>
<td>Select from a variety of reports and tests to help solve problems with the product.</td>
</tr>
<tr>
<td>Retrieve Diagnostic Data</td>
<td>Export product information to a file that can be useful for detailed problem analysis.</td>
</tr>
<tr>
<td>NOTE: This item is available only if an administrator password is set from the Security tab.</td>
<td></td>
</tr>
<tr>
<td>Firmware Upgrade</td>
<td>Download and install product firmware upgrade files.</td>
</tr>
<tr>
<td>Restore Factory Settings</td>
<td>Restore product settings to factory defaults.</td>
</tr>
</tbody>
</table>
Security tab

Table 6-5  HP Embedded Web Server Security tab

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General Security</strong></td>
<td>Configure an administrator password so you can restrict access to certain features on the product.</td>
</tr>
<tr>
<td></td>
<td>Set PJL password for processing PJL commands.</td>
</tr>
<tr>
<td></td>
<td>Set file system access and firmware upgrade security.</td>
</tr>
<tr>
<td></td>
<td>Enable or disable the Host USB port on the control panel or the USB connectivity port on the formatter for printing directly from a computer.</td>
</tr>
<tr>
<td></td>
<td>View the status of all security settings.</td>
</tr>
<tr>
<td><strong>Access Control</strong></td>
<td>Configure access to product functions for specific individuals or groups. Also set up user accounts and select the method by which individuals sign in to the product.</td>
</tr>
<tr>
<td><strong>Protect Stored Data</strong></td>
<td>Configure and manage the internal hard drive for the product. This product includes an encrypted hard drive for maximum security.</td>
</tr>
<tr>
<td></td>
<td>Configure settings for jobs that are stored on the product hard drive.</td>
</tr>
<tr>
<td><strong>Certificate Management</strong></td>
<td>Install and manage security certificates for access to the product and the network.</td>
</tr>
<tr>
<td><strong>Self Test</strong></td>
<td>Verify that the security functions are running according to expected system parameters.</td>
</tr>
</tbody>
</table>

HP Web Services tab

Use the **HP Web Services** tab to configure and enable HP Web Services for this product. You must enable HP Web Services to use the HP ePrint feature.

Networking tab

Use the **Networking** tab to configure and secure network settings for the product when it is connected to an IP-based network. This tab does not display if the product is connected to other types of networks.

Other Links list

**NOTE:** You can configure which links display in the **Other Links** list by using the **Edit Other Links** menu on the **General** tab. The following are the default links.

Table 6-6  HP Embedded Web Server Other Links list

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>HP Instant Support</strong></td>
<td>Connects you to the HP Web site to help you find solutions to product problems.</td>
</tr>
<tr>
<td><strong>Shop for Supplies</strong></td>
<td>Connects to the HP SureSupply Web site, where you can receive information on options for purchasing original HP supplies, such as toner cartridges and paper.</td>
</tr>
<tr>
<td><strong>Product Support</strong></td>
<td>Connects to the support site for the product, from which you can search for help regarding various topics.</td>
</tr>
</tbody>
</table>
HP Utility (Mac OS X)

HP Utility is a software program that provides access to the product in Mac OS X.

You can use HP Utility when the product uses a USB cable or is connected to a TCP/IP-based network.

Open HP Utility

From the Finder, click Applications, click Utilities, and then click HP Utility.

If HP Utility is not included in the Utilities list, use the following procedure to open it:

1. At the computer, open the Apple menu, click the System Preferences menu, and then click the Print & Fax icon (OS X v10.5 and 10.6) or the Print & Scan icon (OS X v10.7).
2. Select the product in the left side of the window.
3. Click the Options & Supplies button.
4. Click the Utility tab.
5. Click the Open Printer Utility button.

HP Utility features

HP Utility consists of pages that you open by clicking in the All Settings list. At the top of any page, click the icons to access HP Web sites for the following information:

- HP Support
- Supplies
- Registration
- Recycling

The following table describes the tasks that you can perform with HP Utility.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information And Support</td>
<td>Supplies Status</td>
<td>Shows the product supplies status and provides links for ordering supplies online.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Device Information</td>
<td></td>
<td>Shows information about the currently selected product.</td>
</tr>
<tr>
<td>File Upload</td>
<td></td>
<td>Transfers files from the computer to the product.</td>
</tr>
<tr>
<td>Upload Fonts</td>
<td></td>
<td>Transfers font files from the computer to the product.</td>
</tr>
<tr>
<td>HP ePrintCenter</td>
<td></td>
<td>Accesses the HP ePrintCenter.</td>
</tr>
<tr>
<td>Update Firmware</td>
<td></td>
<td>Transfers a firmware update file to the product.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>NOTE:</strong> This option is available only after you open the View menu and select the Show Advanced Options item.</td>
</tr>
<tr>
<td>Commands</td>
<td></td>
<td>Sends special characters or print commands to the product after the print job.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>NOTE:</strong> This option is available only after you open the View menu and select the Show Advanced Options item.</td>
</tr>
<tr>
<td>Menu</td>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Printer Settings</td>
<td>Supplies Management</td>
<td>Configures how the product should behave when supplies are nearing the end of their estimated life.</td>
</tr>
<tr>
<td></td>
<td>Trays Configuration</td>
<td>Changes the default tray settings.</td>
</tr>
<tr>
<td></td>
<td>Output Devices</td>
<td>Manages settings for optional output accessories.</td>
</tr>
<tr>
<td></td>
<td>Duplex Mode</td>
<td>Turns on the automatic two-sided printing mode.</td>
</tr>
<tr>
<td></td>
<td>Protect Direct Ports</td>
<td>Disables printing over USB or parallel ports.</td>
</tr>
<tr>
<td></td>
<td>Stored Jobs</td>
<td>Manages print jobs that are stored on the product hard disk.</td>
</tr>
<tr>
<td></td>
<td>Network Settings</td>
<td>Configures the network settings, such as the IPv4 and IPv6 settings.</td>
</tr>
<tr>
<td></td>
<td>Additional Settings</td>
<td>Provides access to the HP Embedded Web Server.</td>
</tr>
</tbody>
</table>
Use HP Web Jetadmin software

HP Web Jetadmin is an award-winning, industry-leading tool for efficiently managing a wide variety of networked HP products, including printers, multifunction products, and digital senders. This single solution allows you to remotely install, monitor, maintain, troubleshoot, and secure your printing and imaging environment — ultimately increasing business productivity by helping you save time, control costs, and protect your investment.

HP Web Jetadmin upgrades are periodically made available to provide support for specific product features. Go to www.hp.com/go/webjetadmin and click the Self Help and Documentation link to learn more about upgrades.
Economy settings

Print with EconoMode

This product has an EconoMode option for printing drafts of documents. Using EconoMode can use less toner, which might extend the life of the toner cartridge. However, using EconoMode can also reduce print quality.

HP does not recommend the full-time use of EconoMode. If EconoMode is used full-time, the toner supply might outlast the mechanical parts in the toner cartridge. If print quality begins to degrade and is no longer acceptable, consider replacing the toner cartridge.

**NOTE:** This feature is available with the PCL 6 print driver for Windows. If you are not using that driver, you can enable the feature by using the HP Embedded Web Server.

1. From the software program, select the **Print** option.
2. Select the product, and then click the **Properties** or **Preferences** button.
3. Click the **Paper/Quality** tab.
4. Click the **EconoMode** check box.
5. Click the **OK** button to close the **Document Properties** dialog box. In the **Print** dialog, click the **OK** button to print the job.

Optimize speed or energy use

By default the product stays warm between jobs to optimize speed and print the first page of jobs faster. You can set the product to cool between jobs, which conserves energy.

1. On the product control panel, press the Home button.
2. Open each of the following menus:
   - **Administration**
   - **General Settings**
   - **Energy Settings**
   - **Optimum Speed/Energy Usage**
3. Highlight the option that you want to use, and then press the **OK** button.

Set sleep mode

1. On the product control panel, press the Home button.
2. Open each of the following menus:
   - **Administration**
   - **General Settings**
• Energy Settings
• Sleep Timer Settings

3. Open the **Sleep Mode/Auto Off After** menu, and then use the keypad to set the appropriate time. Press the **OK** button.

4. Open the **Sleep Mode/Auto Off Timer** menu, and select the **Enabled** option. Press the **OK** button.

**NOTE:** The sleep-mode default time is 45 minutes.

**NOTE:** When the product is in sleep mode, the power-button light flashes.

---

**Set the sleep schedule**

**NOTE:** You must configure the date and time settings before you can use the **Sleep Schedule** feature.

1. On the product control panel, press the **Home** button.

2. Open the following menus:
   - **Administration**
   - **General Settings**
   - **Date/Time Settings**

3. Open the **Date/Time Format** menu and configure the following settings:
   - **Date Format**
   - **Time Format**

4. To save the changes, press the **OK** button.

5. Open the **Date/Time** menu and configure the following settings:
   - **Date**
   - **Time**
   - **Time Zone**

   If you are in an area that uses daylight savings time, select the **Adjust for Daylight Savings** box.

6. To save the changes, press the **OK** button.

7. Press the back-arrow button to return to the **Administration** screen.

8. Open the following menus:
   - **General Settings**
   - **Energy Settings**
   - **Sleep Schedule**

9. Select the **Add** option, and then select the type of event to schedule: **Wake** or **Sleep**.
10. Configure the following settings:
   - Time
   - Event Days

11. To save the changes, press the OK button.
Product security features

Security statements

The product supports security standards and recommended protocols that help you keep the product secure, protect critical information on your network, and simplify the way you monitor and maintain the product.

For in-depth information about HP's secure imaging and printing solutions, visit www.hp.com/go/secureprinting. The site provides links to white papers and FAQ documents about security features.

IP Security

IP Security (IPsec) is a set of protocols that control IP-based network traffic to and from the product. IPsec provides host-to-host authentication, data integrity, and encryption of network communications.

For products that are connected to the network and have an HP Jetdirect print server, you can configure IPsec by using the Networking tab in the HP Embedded Web Server.

Sign in to the product

Some features on the product control panel can be secured so that unauthorized people cannot use them. When a feature is secured, the product prompts you to sign in before you can use it. You can also sign in without waiting for a prompt by pressing the Home button on the product control panel, and then selecting the Sign In option.

Typically, you use the same user name and password that you use to sign in to your computer on the network. Consult the network administrator for this product if you have questions about which credentials to use.

After you have signed in to the product, a Sign Out option displays on the control panel. To maintain security for the product, select the Sign Out option when you have finished using the product.

Assign a system password

Assign an administrator password for access to the product and the HP Embedded Web Server so that unauthorized users cannot change the product settings.

1. Open the HP Embedded Web Server by entering the product IP address into the address line of a Web browser.
2. Click the Security tab.
3. Open the General Security menu.
4. In the Username field, enter the name to associate with the password.
5. Enter the password in the New Password field, and then enter it again in the Verify password field.

NOTE: If you are changing an existing password, you must first enter the existing password in the Old Password field.
6. Click the Apply button. Make note of the password and store it in a safe place.
Encryption support: HP High-Performance Secure Hard Disks

The hard disk provides hardware-based encryption so you can securely store sensitive data without impacting product performance. This hard disk uses the latest Advanced Encryption Standard (AES) and has versatile time-saving features and robust functionality.

Use the Security menu in the HP Embedded Web Server to configure the disk.

For more information about the encrypted hard disk, see the HP High-Performance Secure Hard Disk Setup Guide.

1. Go to www.hp.com/support.
2. Enter Secure Hard Disk into the search field and press Enter.
3. Click the HP High-Performance Secure Hard Disk Drive link.
4. Click the Manuals link.

Lock the formatter cage

The formatter cage, on the back of the product, has a slot that you can use to attach a security cable. Locking the formatter cage prevents someone from removing valuable components from the formatter.
Upgrade the product firmware

Software and firmware upgrades and installation instructions for this product are available at www.hp.com/support/lj700M712. Click Support & Drivers, click the operating system, and then select the download for the product.
7 Solve problems

- Solve problems checklist
- Factors that affect product performance
- Restore factory-set defaults
- Control-panel help
- Paper feeds incorrectly or becomes jammed
- Clear jams
- Change jam recovery
- Improve print quality
- The product does not print or it prints slowly
- Solve easy-access USB printing problems
- Solve USB connection problems
- Solve wired network problems
- Solve product software problems (Windows)
- Solve product software problems (Mac OS X)
- Remove software (Windows)
- Remove the print driver (Mac OS X)
Solve problems checklist

Follow these steps when trying to solve a problem with the product.

1. If the control panel is blank or black, complete these steps:
   a. Check the power cable.
   b. Check that the power is turned on.
   c. Make sure that the line voltage is correct for the product power configuration. (See the label that is on the back of the product for voltage requirements.) If you are using a power strip and its voltage is not within specifications, connect the product directly into the electrical outlet. If it is already connected into the outlet, try a different outlet.
   d. If none of these measures restores power, contact HP Customer Care.

2. The control panel should indicate a Ready status. If an error message displays, resolve the error.

3. Check the cabling.
   a. Check the cable connection between the product and the computer or network port. Make sure that the connection is secure.
   b. Make sure that the cable itself is not faulty by using a different cable, if possible.
   c. Check the network connection.

4. Ensure that the selected paper size and type meet specifications. Also open the Trays menu on the product control panel and verify that the tray is configured correctly for the paper type and size.

5. Print a configuration page. If the product is connected to a network, an HP Jetdirect page also prints.
   a. On the product control panel, press the Home button.
   b. Open the following menus:
      - Administration
      - Reports
      - Configuration/Status Pages
   c. Select the Configuration Page option.
   d. Highlight the Print option, and then press the OK button to print the page.

If the pages do not print, check that at least one tray contains paper.
If the page jams in the product, follow the instructions on the control panel to clear the jam.
If the page does not print correctly, the problem is with the product hardware. Contact HP Customer Care.
If the page prints correctly, then the product hardware is working. The problem is with the computer you are using, with the print driver, or with the program.
6. Verify that you have installed the print driver for this product. Check the program to make sure that you are using the print driver for this product. The print driver is on the CD that came with the product. You can also download the print driver from this Web site: www.hp.com/go/lj700M712_software.

7. Print a short document from a different program that has worked in the past. If this solution works, then the problem is with the program. If this solution does not work (the document does not print), complete these steps:

   a. Try printing the job from another computer that has the product software installed.

   b. If you connected the product to the network, connect the product directly to a computer with a USB cable. Redirect the product to the correct port, or reinstall the software, selecting the new connection type that you are using.

   **NOTE:** The product will arrive with the USB port disabled. To enable the USB port and use it to test the product’s connectivity, ensure the product is in the **Ready** state.
Factors that affect product performance

Several factors affect the time it takes to print a job:

- Maximum product speed, measured in pages per minute (ppm)
- The use of special paper (such as transparencies, heavy paper, and custom-size paper)
- Product processing and download time
- The complexity and size of graphics
- The speed of the computer you are using
- The USB connection
- The product I/O configuration
- The network operating system and configuration (if applicable)
- The print driver that you are using
Restore factory-set defaults

1. On the product control panel, press the Home button.

2. Open the following menus:
   - Administration
   - General Settings
   - Restore Factory Settings

3. Select one or more categories of settings from the list, and then select the Reset option, and then press the OK button.
Control-panel help

The product has a built-in Help system that explains how to use each screen. To open the Help system, press the Help button on the control panel.

For some screens, the Help opens to a global menu where you can search for specific topics. You can browse through the menu structure by pressing the arrow buttons on the control panel.

For screens that contain settings for individual jobs, the Help opens to a topic that explains the options for that screen.
Paper feeds incorrectly or becomes jammed

- The product does not pick up paper
- The product picks up multiple sheets of paper
- Prevent paper jams

The product does not pick up paper

If the product does not pick up paper from the tray, try these solutions.

1. Open the product and remove any jammed sheets of paper.
2. Load the tray with the correct size of paper for your job.
3. Make sure the paper size and type are set correctly on the product control panel.
4. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides to the appropriate indentation in the tray.
5. Check the product control panel to see if the product is waiting for you to acknowledge a prompt to feed the paper manually. Load paper, and continue.
6. The rollers above the tray might be contaminated. Clean the rollers with a lint-free cloth dampened with warm water.

The product picks up multiple sheets of paper

If the product picks up multiple sheets of paper from the tray, try these solutions.

1. Remove the stack of paper from the tray and flex it, rotate it 180 degrees, and flip it over. Do not fan the paper. Return the stack of paper to the tray.
2. Use only paper that meets HP specifications for this product.
3. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different package.
4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray, straighten the stack, and then return some of the paper to the tray.
5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides to the appropriate indentation in the tray.
6. Make sure the printing environment is within recommended specifications.

Prevent paper jams

To reduce the number of paper jams, try these solutions.

1. Use only paper that meets HP specifications for this product.
2. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different package.
3. Use paper that has not previously been printed or copied on.
4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray, straighten the stack, and then return some of the paper to the tray.
5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides so they are touching the paper stack without bending it.

6. Make sure that the tray is fully inserted in the product.

7. If you are printing on heavy, embossed, or perforated paper, use the manual feed feature and feed sheets one at a time.

8. On the product control panel, press the Home button and then select the **Trays** item. Verify that the tray is configured correctly for the paper type and size.

9. Make sure the printing environment is within recommended specifications.
Clear jams

Jam locations

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Duplexer</td>
</tr>
<tr>
<td>2</td>
<td>Fuser jam-access door</td>
</tr>
<tr>
<td>3</td>
<td>Output bin</td>
</tr>
<tr>
<td>4</td>
<td>Top cover (access to the toner cartridge)</td>
</tr>
<tr>
<td>5</td>
<td>Tray 1</td>
</tr>
<tr>
<td>6</td>
<td>Tray 2 jam-access door</td>
</tr>
<tr>
<td>7</td>
<td>Jam-access for the 500-sheet input tray</td>
</tr>
</tbody>
</table>

Auto-navigation for clearing jams

The auto-navigation feature assists you in clearing jams by providing step-by-step instructions on the control panel. When you complete a step, the product displays instructions for the next step until you have completed all steps in the procedure.
Clear jams in the output-bin area

1. If paper is visible from the output bin, grasp the leading edge and remove it.

Clear jams in Tray 1

1. Slowly pull the jammed paper out of the product.
Clear jams in Tray 2 or Tray 3

1. Open the right-side access door. If the jammed page is visible, gently pull it out of the product.

2. If you were not able to clear the jam by using the right-side access door, slide the tray out of the product.

3. Remove any damaged paper from the tray.
4. If the edge of the paper is visible in the feed area, slowly pull the paper toward the left side and then out of the product.

**NOTE:** Do not force the paper if it will not move easily. If the paper is stuck in a tray, try removing it through the tray above (if applicable) or through the toner-cartridge area.

5. Close the tray.

**NOTE:** Before replacing the tray, make sure the paper is flat in the tray at all four corners and below the tabs on the guides.

6. Close the right-side access door.
Clear jams in the 500-sheet trays

1. Open the right-side access door and the 500-sheet tray jam-access door.

2. Remove the 500-sheet tray.

3. If the edge of the paper is visible in the feed area, slowly pull the paper toward the right side and out of the product.

   **NOTE:** Do not force the paper if it will not move easily. If the paper is stuck in a tray, try removing it through the tray above (if applicable) or through the upper, right door.
4. Close the 500-sheet tray.

5. Close the right-side access door and the 500-sheet tray jam-access door.
Clear jams in the 3,500-sheet high-capacity tray

1. Open the right and left sides of the tray.

2. Remove any damaged sheets of paper.

3. Above the right-side tray, press the green button to release the jam-access plate.
4. If jammed paper is in the feed area, pull it down to remove it.

5. Push up on the jam-access plate to close it.

6. Close the right and left sides of the tray.
7. Open the jam-access door on the right side of the high-capacity tray cabinet.

8. Lift up the jam-release plate and remove any jammed paper.

9. Close the jam-access door on the right side of the high-capacity tray cabinet.
Clear jams from the toner-cartridge area

1. Press the cartridge-door-release button.

2. Open the cartridge door.

3. Remove the toner cartridge.

   **CAUTION:** To prevent damage to the toner cartridge, do not expose it to light for more than a few minutes.
4. Pull the green tab down to open the metal plate inside the product.

5. Slowly pull the paper out of the product. Be careful to not tear the paper.

**CAUTION:** Avoid spilling loose toner. Use a dry, lint-free cloth to clean any toner that might have fallen into the product. If loose toner falls into the product, it might cause temporary problems with print quality. Loose toner should clear from the paper path after a few pages are printed. If toner gets on your clothing, wipe it off with a dry cloth and wash clothing in cold water. (Hot water sets toner into fabric.)
6. Replace the toner cartridge.

7. Close the cartridge door.
Clear jams in the fuser

1. Open the fuser door on the left side of the product.

   **CAUTION:** The fuser can be hot while the product is in use.

2. Push down on the green tab to open the fuser jam-access cover.

3. Remove any paper from the fuser.
4. Close the fuser jam-access cover.

5. Close the fuser door.
Clear jams from the duplexer

1. Remove the duplexer.

2. Remove any paper from the duplexer.

3. Reinstall the duplexer.
Change jam recovery

This product provides a jam recovery feature that reprints jammed pages.

1. On the product control panel, press the Home button.

2. Open the following menus:
   - Administration
   - General Settings
   - Jam Recovery

3. Select one of the following options:
   - **Auto**: The product attempts to reprint jammed pages when sufficient memory is available. This is the default setting.
   - **Off**: The product does not attempt to reprint jammed pages. Because no memory is used to store the most recent pages, performance is optimal.

   **NOTE:** Some pages can be lost if the product runs out of paper while printing a duplex job with Jam Recovery set to Off.

   - **On**: The product always reprints jammed pages. Additional memory is allocated to store the last few pages printed.

4. To save your changes, press the OK button.
Improve print quality

Print from a different software program

Try printing from a different software program. If the page prints correctly, the problem is with the software program from which you were printing.

Set the paper-type setting for the print job

Check the paper type setting if you are printing from a software program and the pages have any of these problems:

- smeared print
- fuzzy print
- dark print
- curled paper
- scattered dots of toner
- loose toner
- small areas of missing toner

Check the paper type setting (Windows)

1. From the software program, select the **Print** option.
2. Select the product, and then click the **Properties** or **Preferences** button.
3. Click the **Paper/Quality** tab.
4. From the **Paper type** drop-down list, click the **More...** option.
5. Expand the list of **Type is:** options.
6. Expand the category of paper types that best describes your paper.
7. Select the option for the type of paper you are using, and click the **OK** button.
8. Click the **OK** button to close the **Document Properties** dialog box. In the **Print** dialog box, click the **OK** button to print the job.

Check the paper type setting (Mac OS X)

1. Click the **File** menu, and then click the **Print** option.
2. In the **Printer** menu, select the product.
3. By default, the print driver displays the **Copies & Pages** menu. Open the menus drop-down list, and then click the **Finishing** menu.
4. Select a type from the **Media Type** drop-down list.
5. Click the **Print** button.
Check the toner-cartridge status

Follow these steps to check the estimated life remaining in the toner cartridges and if applicable, the status of other replaceable maintenance parts.

1. On the product control panel, press the Home button.
2. Open the following menus:
   - Administration
   - Reports
   - Configuration/Status Pages
3. Select the Supplies Status option.
4. Highlight the Print option, and then press the OK button to print the report.
5. Check the percent of life remaining for the toner cartridges and if applicable, the status of other replaceable maintenance parts.

   Print quality problems can occur when using a toner cartridge that is at its estimated end of life. The supplies status page indicates when a supply level is very low. After an HP supply has reached the very low threshold, HP’s premium protection warranty on that supply has ended.

   The supply does not need to be replaced now unless the print quality is no longer acceptable. Consider having a replacement available to install when print quality is no longer acceptable.

   If you determine that you need to replace a toner cartridge or other replaceable maintenance parts, the supplies status page lists the genuine HP part numbers.
6. Check to see if you are using a genuine HP cartridge.

   A genuine HP toner cartridge has the words “HP” on it, or has the HP logo on it. For more information on identifying HP cartridges go to www.hp.com/go/learnaboutsupplies.

   HP cannot recommend the use of non-HP supplies, either new or remanufactured. Because they are not HP products, HP cannot influence their design or control their quality. If you are using a refilled or remanufactured toner cartridge and are not satisfied with the print quality, replace the toner cartridge with a genuine HP toner cartridge.

Print a cleaning page

Print a cleaning page to remove dust and excess toner from the paper path if you are having any of the following problems:

- Specks of toner are on the printed pages.
- Toner is smearing on the printed pages.
- Repeated marks occur on the printed pages.

Use the following procedure to print a cleaning page.
1. On the product control panel, press the Home button.

2. Open the following menus:
   - Device Maintenance
   - Calibration/Cleaning
   - Cleaning Page

3. Press the OK button to print the page.

4. The cleaning process can take several minutes. When it is finished, discard the printed page.

**Visually inspect the toner cartridge**

1. Remove the toner cartridge from the product, and verify that the sealing tape has been removed.

2. Check the memory chip for damage.

3. Examine the surface of the green imaging drum on the toner cartridge.

   **CAUTION:** Do not touch the imaging drum. Fingerprints on the imaging drum can cause print-quality problems.

4. If you see any scratches, fingerprints, or other damage on the imaging drum, replace the toner cartridge.

5. If the imaging drum does not appear to be damaged, rock the toner cartridge gently several times and reinstall it. Print a few pages to see if the problem has resolved.

**Check paper and the printing environment**

**Use paper that meets HP specifications**

Use different paper if you are having any of the following problems:

- The printing is too light or seems faded in areas.
- Specks of toner are on the printed pages.
- Toner is smearing on the printed pages.
- Printed characters seem misformed.
- Printed pages are curled.

Always use a paper type and weight that this product supports. In addition, follow these guidelines when selecting paper:

- Use paper that is of good quality and free of cuts, nicks, tears, spots, loose particles, dust, wrinkles, voids, staples, and curled or bent edges.
- Use paper that has not been previously printed on.
Check the environment

Environmental conditions can directly affect print quality, and they are a common cause for paper-feeding problems. Try the following solutions:

- Move the product away from drafty locations, such as air-conditioning vents, or open windows or doors.
- Make sure the product is not exposed to temperatures or humidity outside of product specifications.
- Do not place the product in a confined space, such as a cabinet.
- Place the product on a sturdy, level surface.
- Remove anything that is blocking the vents on the product. The product requires good air flow on all sides, including the top.
- Protect the product from airborne debris, dust, steam, grease, or other elements that can leave residue inside the product.

Check the EconoMode settings

HP does not recommend the full-time use of EconoMode. If EconoMode is used full-time, the toner supply might outlast the mechanical parts in the toner cartridge. If print quality begins to degrade and is no longer acceptable, consider replacing the toner cartridge.

**NOTE:** This feature is available with the PCL 6 print driver for Windows. If you are not using that driver, you can enable the feature by using the HP Embedded Web Server.

Follow these steps if the entire page is too dark or too light.

1. From the software program, select the **Print** option.
2. Select the product, and then click the **Properties** or **Preferences** button.
3. Click the **Paper/Quality** tab, and locate the **Print Quality** area.
4. If the entire page is too dark, use these settings:
   - Select the **600 dpi** option.
   - Select the **EconoMode** check box to enable it.

If the entire page is too light, use these settings:

- Select the **FastRes 1200** option.
- Clear the **EconoMode** check box to disable it.

5. Click the **OK** button to close the **Document Properties** dialog box. In the **Print** dialog, click the **OK** button to print the job.
Try using a different print driver if you are printing from a software program and the printed pages have unexpected lines in graphics, missing text, missing graphics, incorrect formatting, or substituted fonts. The following print drivers are available at www.hp.com/go/lj700M712_software.

<table>
<thead>
<tr>
<th>Print Driver</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>HP PCL 6 driver</strong></td>
<td>Provided as the default driver on the product CD. This driver is automatically installed unless you select a different one.</td>
</tr>
<tr>
<td></td>
<td>Recommended for all Windows environments</td>
</tr>
<tr>
<td></td>
<td>Provides the overall best speed, print quality, and product-feature support for most users</td>
</tr>
<tr>
<td></td>
<td>Developed to align with the Windows Graphic Device Interface (GDI) for the best speed in Windows environments</td>
</tr>
<tr>
<td></td>
<td>Might not be fully compatible with third-party and custom software programs that are based on PCL 5</td>
</tr>
<tr>
<td><strong>HP UPD PS driver</strong></td>
<td>Recommended for printing with Adobe® software programs or with other highly graphics-intensive software programs</td>
</tr>
<tr>
<td></td>
<td>Provides support for printing from postscript emulation needs, or for postscript flash font support</td>
</tr>
<tr>
<td><strong>HP UPD PCL 5</strong></td>
<td>Recommended for general office printing in Windows environments</td>
</tr>
<tr>
<td></td>
<td>Compatible with previous PCL versions and older HP LaserJet products</td>
</tr>
<tr>
<td></td>
<td>The best choice for printing from third-party or custom software programs</td>
</tr>
<tr>
<td></td>
<td>The best choice when operating with mixed environments, which require the product to be set to PCL 5 (UNIX, Linux, mainframe)</td>
</tr>
<tr>
<td></td>
<td>Designed for use in corporate Windows environments to provide a single driver for use with multiple product models</td>
</tr>
<tr>
<td></td>
<td>Preferred when printing to multiple product models from a mobile Windows computer</td>
</tr>
<tr>
<td><strong>HP UPD PCL 6</strong></td>
<td>Recommended for printing in all Windows environments</td>
</tr>
<tr>
<td></td>
<td>Provides the overall best speed, print quality, and printer feature support for most users</td>
</tr>
<tr>
<td></td>
<td>Developed to align with Windows Graphic Device Interface (GDI) for best speed in Windows environments</td>
</tr>
<tr>
<td></td>
<td>Might not be fully compatible with third-party and custom software programs that are based on PCL 5</td>
</tr>
</tbody>
</table>

Set the individual tray alignment

Adjust the alignment for individual trays when text or images are not centered or aligned correctly on the printed page.

1. On the product control panel, press the Home button.
2. Open the following menus:
3. Select the tray that you want to adjust, and press the OK button.

4. Select the adjustment that you want to make and use the arrow buttons to adjust the image on the page. Press the OK button to save the changes.

5. To verify the results, select the Print Test Page option, and press the OK button. Make further adjustments if necessary.
The product does not print or it prints slowly

The product does not print

If the product does not print at all, try the following solutions.

1. Make sure the product is turned on and that the control panel indicates it is ready.
   – If the control panel does not indicate the product is ready, turn the product off and then on again.
   – If the control panel indicates the product is ready, try sending the job again.

2. If the control panel indicates the product has an error, resolve the error and then try sending the job again.

3. Make sure the cables are all connected correctly. If the product is connected to a network, check the following:
   – Check the light next to the network connection on the product. If the network is active, the light is green.
   – Make sure that you are using a network cable and not a phone cord to connect to the network.
   – Make sure the network router, hub, or switch is turned on and that it is working correctly.

4. Install the HP software from the CD that came with the product or use the UPD print driver. Using generic print drivers can cause delays clearing jobs from the print queue.

5. From the list of printers on your computer, right-click the name of this product, click Properties, and open the Ports tab.
   – If you are using a network cable to connect to the network, make sure the printer name listed on the Ports tab matches the product name on the product configuration page.
   – If you are using a USB cable and are connecting to a wireless network, make sure the box is checked next to Virtual printer port for USB.

6. If you are using a personal firewall system on the computer, it might be blocking communication with the product. Try temporarily disabling the firewall to see if it is the source of the problem.

7. If your computer or the product is connected to a wireless network, low signal quality or interference might be delaying print jobs.

The product prints slowly

If the product prints, but it seems slow, try the following solutions.

1. Make sure the computer meets the minimum specifications for this product. For a list of specifications, go to this Web site: www.hp.com/support/lj700M712.

2. When you configure the product to print on some paper types, such as heavy paper, the product prints more slowly so it can correctly fuse the toner to the paper. If the paper type setting is not correct for the type of paper you are using, change the setting to the correct paper type.
Solve easy-access USB printing problems

- The Retrieve From USB menu does not open when you insert the USB flash drive
- The file does not print from the USB flash drive
- The file that you want to print is not listed in the Retrieve from USB menu

The Retrieve From USB menu does not open when you insert the USB flash drive

1. You must enable this feature before you can use it.
   a. On the product control panel, press the Home button.
   b. Open the following menus:
      - Administration
      - General Settings
      - Enable Retrieve from USB
   c. Highlight the Enable option, and then press the OK button.

2. You might be using a USB flash drive or a file system that this product does not support. Save the files on a standard USB flash drive that uses File Allocation Table (FAT) file systems. The product supports FAT32 USB flash drives.

3. If another menu is already open, close that menu and then reinsert the USB flash drive.

4. The USB flash drive might have multiple partitions. (Some USB flash drive manufacturers install software on the accessory that creates partitions, similar to a CD.) Reformat the USB flash drive to remove the partitions, or use a different USB flash drive.

5. The USB flash drive might require more power than the product can provide.
   a. Remove the USB flash drive.
   b. Turn the product off and then on.
   c. Use a USB flash drive that has its own power supply or that requires less power.

6. The USB flash drive might not be functioning correctly.
   a. Remove the USB flash drive.
   b. Turn the product off and then on.
   c. Try printing from another USB flash drive.

The file does not print from the USB flash drive

1. Make sure that paper is in the tray.

2. Check the control panel for messages. If paper is jammed in the product, clear the jam.
The file that you want to print is not listed in the Retrieve from USB menu

1. You might be trying to print a file type that the USB printing feature does not support. The product supports .pdf, .prn, .pcl, .ps, and .cht file types.

2. You might have too many files in a single folder on the USB flash drive. Reduce the number of files in the folder by moving them to subfolders.

3. You might be using a character set for the file name that the product does not support. In this case, the product replaces the file names with characters from a different character set. Rename the files using ASCII characters.
Solve USB connection problems

If you have connected the product directly to a computer, configure the following setting so the product wakes from sleep mode whenever it receives a print job.

1. On the product control panel, press the Home button.
2. Open the following menus:
   - Administration
   - General Settings
   - Energy Settings
   - Sleep Timer Settings
   - Wake/Auto On Events
3. Highlight the All events option and press the OK button.

If you have connected the product directly to a computer, check the cable.

- Verify that the cable is connected to the computer and to the product.
- Verify that the cable is not longer than 2 m (6.5 ft). Try using a shorter cable.
- Verify that the cable is working correctly by connecting it to another product. Replace the cable if necessary.
Solve wired network problems

Check the following items to verify that the product is communicating with the network. Before beginning, print a configuration page from the product control panel and locate the product IP address that is listed on this page.

- **The product has a poor physical connection**
- **The computer is using the incorrect IP address for the product**
- **The computer is unable to communicate with the product**
- **The product is using incorrect link and duplex settings for the network**
- **New software programs might be causing compatibility problems**
- **The computer or workstation might be set up incorrectly**
- **The product is disabled, or other network settings are incorrect**

The product has a poor physical connection

1. Verify that the product is attached to the correct network port using a cable of the correct length.
2. Verify that cable connections are secure.
3. Look at the network port connection on the back of the product, and verify that the amber activity light and the green link-status light are lit.
4. If the problem continues, try a different cable or port on the hub.

The computer is using the incorrect IP address for the product

1. Open the printer properties and click the **Ports** tab. Verify that the current IP address for the product is selected. The product IP address is listed on the product configuration page.
2. If you installed the product using the HP standard TCP/IP port, select the box labeled **Always print to this printer, even if its IP address changes.**
3. If you installed the product using a Microsoft standard TCP/IP port, use the hostname instead of the IP address.
4. If the IP address is correct, delete the product and then add it again.

The computer is unable to communicate with the product

1. Test network communication by pinging the product.
   a. Open a command-line prompt on your computer. For Windows, click **Start**, click **Run**, and then type `cmd`.
   b. Type `ping` followed by a space and then the IP address for your product.
   c. If the window displays round-trip times, the network is working.
2. If the ping command failed, verify that the network hubs are on, and then verify that the network settings, the product, and the computer are all configured for the same network.
The product is using incorrect link and duplex settings for the network

HP recommends leaving this setting in automatic mode (the default setting). If you change these settings, you must also change them for your network.

New software programs might be causing compatibility problems

Verify that any new software programs are correctly installed and that they use the correct print driver.

The computer or workstation might be set up incorrectly

1. Check the network drivers, print drivers, and the network redirection.
2. Verify that the operating system is configured correctly.

The product is disabled, or other network settings are incorrect

1. Review the configuration page to check the status of the network protocol. Enable it if necessary.
2. Reconfigure the network settings if necessary.
Solve product software problems (Windows)

A print driver for the product is not visible in the Printer folder

1. Reinstall the product software.

   NOTE: Close any applications that are running. To close an application that has an icon in the system tray, right-click the icon, and select Close or Disable.

2. Try connecting the USB cable to a different USB port on the computer.

An error message was displayed during the software installation

1. Reinstall the product software.

   NOTE: Close any applications that are running. To close an application that has an icon in the system tray, right-click the icon, and select Close or Disable.

2. Check the amount of free space on the drive where you are installing the product software. If necessary, free up as much space as you can, and reinstall the product software.

3. If necessary, run the Disk Defragmenter, and reinstall the product software.

The product is in Ready mode, but nothing prints

1. Print a configuration page, and verify the product functionality.

2. Verify that all of the cables are correctly seated and within specifications. This includes the USB and power cables. Try a new cable.

3. Verify that the product IP address listed on the configuration page matches the IP address for the software port. Use one of the following procedures:

   a. Click Start, or for Windows Vista click the Windows icon in the lower-left corner of the screen.
   b. Click Settings.
   c. Click Printers and Faxes (using the default Start menu view) or click Printers (using the Classic Start menu view).
   d. Right-click the product driver icon, and then select Properties.
   e. Click the Ports tab, and then click Configure Port.
   f. Verify the IP address, and then click OK or Cancel.
   g. If the IP addresses are not the same, delete the driver, and reinstall the driver using the correct IP address.

   Windows 7
   a. Click the Windows icon in the lower-left corner of the screen.
   b. Click Devices and Printers.
c. Right-click the product driver icon, and then select **Printer properties**.

d. Click the **Ports** tab, and then click **Configure Port**.

e. Verify the IP address, and then click **OK** or **Cancel**.

f. If the IP addresses are not the same, delete the driver, and reinstall the driver using the correct IP address.
Solve product software problems (Mac OS X)

- The product name does not appear in the product list in the Print & Fax or the Print & Scan list
- A print job was not sent to the product that you wanted
- When connected with a USB cable, the product does not appear in the Print & Fax or the Print & Scan list after the driver is selected

The product name does not appear in the product list in the Print & Fax or the Print & Scan list

1. Make sure that the cables are connected correctly and the product is on.
2. Print a configuration page to check the product name. Verify that the name on the configuration page matches the product name in the Print & Fax or the Print & Scan list.
3. Replace the USB or network cable with a high-quality cable.
4. If necessary, reinstall the software.

   **NOTE:** Connect the USB or network cable before attempting to reinstall the software.

A print job was not sent to the product that you wanted

1. Open the print queue and restart the print job.
2. Another product with the same or similar name might have received your print job. Print a configuration page to check the product name. Verify that the name on the configuration page matches the product name in the Print & Fax or the Print & Scan list.

When connected with a USB cable, the product does not appear in the Print & Fax or the Print & Scan list after the driver is selected

Software troubleshooting

   ▲ Make sure that your Mac operating system is Mac OS X 10.5 or later.

Hardware troubleshooting

1. Make sure that the product is turned on.
2. Make sure that the USB cable is connected correctly.
3. Make sure that you are using the appropriate high-speed USB cable.
4. Make sure that you do not have too many USB devices drawing power from the chain. Disconnect all of the devices from the chain, and connect the cable directly to the USB port on the computer.
5. Check to see if more than two non-powered USB hubs are connected in a row on the chain. Disconnect all of the devices from the chain, and then connect the cable directly to the USB port on the computer.

   **NOTE:** The iMac keyboard is a non-powered USB hub.
Remove software (Windows)

Windows XP

1. Click Start, Control Panel, and then Add or Remove Programs.
2. Find and select the product from the list.
3. Click the Change/Remove button to remove the software.

Windows Vista

1. Click the Windows icon in the lower-left corner of the screen. Click Control Panel, and then click Programs and Features.
2. Find and select the product from the list.
3. Select the Uninstall/Change option.

Windows 7

1. Click the Windows icon in the lower-left corner of the screen. Click Control Panel, and then under the Programs heading, click Uninstall a program.
2. Find and select the product from the list.
3. Select the Uninstall option.
Remove the print driver (Mac OS X)

You must have administrator rights to remove the software.

1. Open System Preferences.
2. Select Print & Fax.
3. Highlight the product.
4. Click the minus (-) symbol.
5. Delete the print queue, if necessary.
Symbols/Numerics
3,500-sheet high-capacity orientation 38
3,500-sheet high-capacity input capacity 38 part number 52
3,500-sheet high-capacity tray clear jams 137 loading 38
500-sheet input tray part number 52
500-sheet tray capacity 35 clearing paper jams 135 loading 36 orientation 35
A
accessories ordering 44 part number 52
administration menu map description 10
AirPrint connecting to 101 product name 101 support 101 troubleshooting 102 alternative letterhead mode 28 anticounterfeit supplies 46 arrows down, on control panel 8 up, on control panel 8 attention light control panel 8
B
back button control panel 9
bins, output locating 4 blank pages placing between print jobs 98
Bonjour identifying 110 booklets creating (Windows) 85 printing (Mac) 89
browser requirements HP embedded Web Server 110 buttons, control panel 8
C
canceling a print request Mac 92 Windows 90 cartridges imaging drum 53 jams, clearing 140 memory chip 53 non-HP 45, 54 order numbers 54 pull tab 53 recycling 54 replacing 55 sealing tape 53 status messages 8 storage 54 checklist problems 124 cleaning paper path 148 clear button control panel 8 configuration page description 10 configuring IP address 14, 17 paper type or size in trays 26 connecting to AirPrint 101 connection USB with Mac 16 USB with Windows 12 control panel buttons 8 display 8 help 9, 128 lights 8 locating 4 copy settings HP Embedded Web Server 112 counterfeit supplies 46 cover pages printing on different paper (Windows) 80 covers, locating 4 current settings page description 10
D
default gateway, setting 108 deleting stored jobs 97 double-sided printing Mac 87 down arrow control panel 8 drivers changing paper sizes 90 changing settings (Mac) 63 changing settings (Windows) 62 paper types 25 presets (Mac) 87
settings (Mac)  87
universal  60
drum
imaging  53
duplex printing
Mac  87
duplex printing (double-sided) settings (Windows)  69
duplexer
jams, clearing  145
part number  52
duplexing
manually (Mac)  87
manually (Windows)  71

E
Easy-access USB
control panel  9
easy-access USB printing  104
EconoMode setting  117, 150
Embedded Web Server (EWS)
assigning passwords  120
features  110
network connection  110
energy use, optimizing  117
envelope
Tray 1 capacity  29
envelopes
orientation  29
error messages
lights, control panel  8
errors
software  159
Explorer, versions supported
HP Embedded Web Server  110

F
file directory page
description  10
file upload, Mac  114
firmware
update, Mac  114
first page
printing on different paper (Windows)  80
folder button
control panel  8
fonts
upload, Mac  114
formatter
security  121
fraud Web site  46
fuser
jams  143
G
gateway, setting default  108
general configuration
HP Embedded Web Server  111
H
hard disks
encrypted  121
Help button
control panel  8
help, control panel  9, 128
high-capacity tray
clear jams  137
loading  38
home button
control panel  9
HP Embedded Web Server
AirPrint settings  102
copy settings  112
general configuration  111
HP Web Services  113
information pages  111
network settings  113
other links list  113
print settings  112
security settings  113
troubleshooting tools  112
HP Embedded Web Server (EWS)
features  110
network connection  110
HP ePrint Mobile Driver  100
HP ePrint, using  99
HP fraud Web site  46
HP Smart Print  103
HP Universal Print Driver  60
HP Utility  114
HP Utility, Mac  114
HP Web Jetadmin  116
HP Web Services
enabling  113
HP Web Services, enabling  99
HP Web Services, enabling
information pages
HP Embedded Web Server  111
printing or viewing  10
installing
product on wired networks, Mac  17
product on wired networks, Windows  14
software, wired networks (Mac)  18
software, wired networks (Windows)  15
interface ports
locating  5, 6
Internet Explorer, versions supported
HP Embedded Web Server  110
IP address
configuring  14, 17
IP Security  120
IPSec  120
IPv4 address  108
IPv6 address  109
J
jams
3,500-sheet high-capacity tray  137
500-sheet tray  135
auto-navigation  131
causes of  129
duplexer, clearing  145
fuser  143
locations  131
output bin  132
recovery  146
toner-cartridge area  140
Tray 1  132
Tray 2 or Tray 3  133
Jetadmin, HP Web  116
Jetdirect print server
part number  52
job storage
Mac settings  96
job-separator pages  98
jobs, stored
creating (Windows)  94
deleting  97
printing  97
K
keypad
numeric on control panel 8

L
labels
printing (Windows) 77
printing on 40
Tray 1 capacity 29
landscape orientation
changing (Mac) 88
selecting, Windows 75
last page
printing on different paper (Windows) 80
letterhead
configuring alternative mode 28
orientation 29
lights, control panel 8
loading
3,500-sheet high-capacity tray 38
500-sheet tray 36
toner cartridges 53
Tray 1 30
Trays 2 and 3 33

M
Mac
driver settings 63, 87
problems, troubleshooting 161
removing software 163
Mac driver settings
Job Storage 96
Macintosh
HP Utility 114
managing network 108
manual duplex
Mac 87
Windows 71
manual duplexing
orientation 29
memory
included 2
memory chip
toner cartridge 53
memory DIMMs
security 121
menus, control panel
accessing 9
messages
lights, control panel 8
multiple pages per sheet
printing (Mac) 88
printing (Windows) 73
N
Netscape Navigator, versions supported
HP embedded Web Server 110
network settings, changing 108
settings, viewing 108
network settings
HP Embedded Web Server 113
networks, wired
installing product, Mac 17
installing product, Windows 14
non-HP supplies 45, 54
number keys
control panel 8
O
OK button 8
on/off button, locating 4
online help, control panel 9, 128
ordering
supplies and accessories 44
orientation
3,500-sheet high-capacity 38
500-sheet tray 35
changing (Mac) 88
selecting, Windows 75
Tray 1 29
Trays 2 and 3 32
other links list
HP Embedded Web Server 113
output bin
capacity 42
jams 132
locating 4
P
page orientation
changing (Mac) 88
page sizes
scaling documents to fit (Mac) 89
scaling documents to fit (Windows) 83
pages per minute 2
pages per sheet
selecting (Mac) 88
selecting (Windows) 73
paper
3,500-sheet high-capacity input tray capacity 38
3,500-sheet high-capacity tray 38
500-sheet tray capacity 35
configure tray type or size 26
covers, using different paper 80
first and last pages, using different paper 80
jams 129
loading Tray 1 30
loading Trays 2 and 3 33
selecting 149
supported paper sizes 22
supported sizes 22
supported types 25
Tray 1 capacity 29
Trays 2 and 3 capacity 32
paper jams
3,500-sheet high-capacity tray 137
paper pickup problems
solving 129
paper size
changing 90
configure 26
paper sizes
selecting (Mac) 92
selecting custom sizes (Mac) 92
selecting custom sizes (Windows) 90
paper type
configure 26
selecting (Windows) 77
paper types
selecting (Mac) 88
paper, covers
printing (Mac) 89
Index

168

paper, ordering 44
part numbers
  accessories 52
  part number 52
replacement parts 49
supplies 49
toner cartridges 49
trays 52
USB cable 52
wireless print server 52
PCL drivers
  universal 60
PCL font list
  description 10
performance factors
  Tray 1 126
portrait orientation
  changing (Mac) 88
  selecting, Windows 75
ports
  locating 6
power connection
  locating 5, 6
power switch, locating 4
presets (Mac) 87
print drivers
  supported 60
print drivers (Mac)
  changing settings 63
  settings 87
print drivers (Windows)
  changing settings 62
print on both sides
  Mac 87
  Windows 71
print server
  part number 52
print settings
  HP Embedded Web Server 112
printing
  from USB storage accessories 104
  settings (Mac) 87
stored jobs 97
printing on both sides
  settings (Windows) 69
problem-solving
  no response 153
  slow response 153
PS font list
  description 10
pull tab on toner cartridges 53
R
ready light
  control panel 9
recycling supplies 54
removing Mac software 163
replacement parts
  part numbers 49
replacing toner cartridges 55
resize documents
  Mac 89
  Windows 83
restore factory settings 127
S
scale documents
  Mac 89
  Windows 83
sealing tape on toner cartridges 53
security
  encrypted hard disk 121
  security settings
    HP Embedded Web Server 113
  setting
    sleep mode 117
settings
  driver presets (Mac) 87
  drivers 62
  drivers (Mac) 63
  restore factory 127
shortcuts (Windows)
  creating 66
  using 64
sign in
  control panel 120
sleep mode
  disabling 117
  enabling 117
sleep schedule
  setting 118
software
  HP Utility 114
  installing, wired networks (Mac) 18
  installing, wired networks (Windows) 15
  problems 159
uninstalling for Windows 162
uninstalling Mac 163
solving
  direct-connect problems 156
  easy-access USB printing problems 154
  network problems 157
solving problems
  AirPrint 102
special paper
  printing (Windows) 77
special paper for covers
  printing (Mac) 89
speed, optimizing 117
status
  HP Utility, Mac 114
Stop button
  control panel 8
stopping a print request
  Mac 92
  Windows 90
storage, job
  Mac settings 96
stored jobs
  creating (Mac) 96
  creating (Windows) 94
  deleting 97
  printing 97
storing
  toner cartridges 54
storing jobs
  with Windows 94
subnet mask 108
supplies
  counterfeit 46
  non-HP 45, 54
  ordering 44
  part numbers 49
  recycling 54
  replacing toner cartridges 55
  status, viewing with HP Utility 114
supplies status 148
supplies status page
  description 10
supplies, status
  control panel messages 8
supported paper 22
system requirements
  HP Embedded Web Server 110
Index

T
TCP/IP
  manually configuring IPv4 parameters 108
  manually configuring IPv6 parameters 109
toner cartridges
  imaging drum 53
  jams, clearing 140
  loading 53
  memory chip 53
  non-HP 45, 54
  order numbers 54
  part numbers 49
  pull tab 53
  recycling 54
  replacing 55
  sealing tape 53
  status messages 8
  storage 54
toner-cartridge status 148
transparencies
  printing (Windows) 77
  Tray 1 capacity 29
Tray 1
  capacity 29
  jams 132
  loading paper 30
  orientation 29
Tray 2
  clearing jams 133
  loading paper 33
Tray 3
  clearing jams 133
  loading paper 33
trays
  configure 26
  included 2
  loading paper 30
  locating 4
  part numbers 52
Trays 2 and 3
  capacity 32
  orientation 32
troubleshooting
  AirPrint 102
  checklist 124
  direct-connect problems 156
  easy-access USB printing problems 154
  jams 129, 131
  wireless printing
  Mac problems 161
  network problems 157
  paper feed problems 129
  USB connect problems 156
  troubleshooting tools
    HP Embedded Web Server 112
two-sided printing
    settings (Windows) 69
U
  uninstalling Mac software 163
  uninstalling Windows software 162
  universal print driver 60
  up arrow
    control panel 8
  usage page
    description 10
USB
  Easy-access on control panel 9
  USB cable
    part number 52
  USB configuration, Mac 16
  USB configuration, Windows 12
  USB storage accessories
    printing from 104
  USB-connection
    troubleshooting 156
W
  watermarks
    printing (Mac) 92
    printing (Windows) 91
Web browser requirements
  HP Embedded Web Server 110
Web services status page
  description 10
Web sites
  fraud reports 46
  HP Web Jetadmin, downloading 116
  universal print driver 60
Windows
  driver settings 62
  universal print driver 60
Windows print drivers
  supported 60
wireless print server
  part number 52